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INTRODUCTION

This is a brief introduction to Fiery eXpress. It describes the field of application for which the 
software was designed and provides details of the hardware and software requirements 
necessary to run it. It also includes an overview of the program structure.

What is Fiery eXpress?
Fiery eXpress is the perfect tool for anyone wanting to achieve high-quality color 
reproduction. It delivers accurate and consistent color without the need for complicated color 
management settings.

The software runs on Windows and Macintosh OS and is extremely easy to use. The standard 
source, simulation and media profiles provided with the software enable your inkjet printer to 
simulate a wide variety of different output devices on a conventional inkjet printer and 
laser/LED printer.

Thus, Fiery eXpress is ideal for creative designers, photographers, agencies, pre-press houses 
and other small operations as well as for print buyers for whom color-accurate print results 
constitute an important part of their daily work.
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System requirements
The following minimum system requirements are necessary to install and run Fiery eXpress 
successfully.

Operating systems Windows • Windows 7, 8.1, 10

Macintosh • Mac OS X 10.9, 10.10, 10.11

Hardware Windows • 2 GHz Pentium IV PC

• 1024 MB RAM

• 10 GB free hard disk space

• 10/100 MBit network interface card

• 1 available USB port (for the dongle)

• VGA-compatible graphics card

Macintosh • Intel Mac (native)

• 1024 MB RAM

• 10 GB free hard disk space

• 10/100 MBit network interface card

• 1 available USB port (for the dongle)

• VGA-compatible graphics card
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Program folders
Note that the paths to Windows folders given in this section refer to the Windows XP 
operating system. The folder structure on other Windows operating systems may vary slightly.

• Installation folder

Unless you choose a different location, Fiery eXpress is installed by default in the following 
folder:

The application folder contains the following three subfolders:

The following additional tools are located in the Tools and Other folder on the DVD: EFI 
AppleTalk driver, dongle drivers, Unidriver, Acrobat Reader.

Windows C:\Program Files\EFI\Fiery eXpress

Macintosh /Applications/Fiery eXpress

Folder name Contains

Documentation PDF user manuals and online help sets for all supported 
languages

Modules • All the program files required to run Fiery eXpress. The 
main program file is located in this folder.

• Printer drivers

Samples • Linear_01.ps, required for media length correction

• EFI_Form_Offset reference files

Tools • Program update and profile update applications

• PPDs
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• Fiery eXpress folder

You will find all work files directly associated with job processing located in the following 
folders:

The folder EFI eXpress contains the following subfolders:

Windows ..\Documents and Settings\All Users\Application 
Data\EFI\EFI eXpress

Macintosh Library/Application Support/EFI/EFI eXpress

Folder name Contains

ControlCharts The Ugra Fogra-MediaWedge V2.2HP.it8 chart used to 
create a Fogra proof

ControlStrip A set of control strips for all supported measuring devices.

Cpsi Files required for or created during processing of PS, EPS 
and PDF files

Licensing Installed license files

In some language versions, the name of the localized 
Application Data folder contains non-ASCII characters. 
This can cause problems. In this case, Fiery eXpress 
automatically creates an Application Data folder with the 
English name, in which the license files are installed.

Monitoring Job processing folder used for recognition of PS, EPS and 
PDF files.

Preferences Contains a log of user settings

Profiles • Grayscale files (*.3cc) and visual correction files (*.vcc)

• Default monitor profile

• Source (reference) profiles

• Spot color files (*.bct)
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Some additional subfolders (e.g. Environments, IT8_CharacterizationData, Screening) are 
also installed. These are currently not used in Fiery eXpress.

• Preferences settings

The preferences settings are saved to the following folders:

Tickets Job tickets of program settings. These files may be required 
by EFI Support when reporting problems.

Work Contains the following subfolders:

• Backup 
Backed up files of program settings. Backup files are used 
to restore a previous program status.

• Export 
Files exported to TIFF format

• JobFolder 
Default hotfolder and spool folder. Copies of jobs from 
external applications are placed in this folder.

• Output 
bco files which are created during job processing. These 
files may be required by EFI Support when reporting 
problems.

• Preview 
A copy of all previewed jobs

• Remote 
EFI Remoteproof Containers (BRP, RPF files)

• Temp 
Temporary files created during job processing.

Windows C:\Documents and Settings\<All Users>\Application 
Data\EFI\EFI_eXpress\Preferences\ 
<username>\EFI eXpress.xml

Macintosh Users/<username>/Library/Preferences/com.efi.eXpress.xml

Folder name Contains
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• Log file

A log file of Fiery eXpress processes is saved to the following folders. This file is required by 
EFI Support when reporting problems:

• Media profiles

Media profiles are installed in the following folders:

About this manual
This manual describes the full set of features available in Fiery eXpress. 

This manual consists of the following chapters:

Chapter 1 explains how to proceed after installation. It contains details of how to license and 
set up Fiery eXpress.

Chapter 2 provides a description of the individual program settings.

Chapter 3 describes the different methods of printing via Fiery eXpress.

Chapter 4 gives a brief introduction to color management. It explains how you can use 
profiles and rendering intents to manipulate color.

Chapter 5 contains step-by-step instructions on how to use different features of Fiery eXpress.

Chapter 6 explains how to uninstall Fiery eXpress.

A glossary at the end of the manual explains some of the terms that you will come across when 
working with Fiery eXpress.

Windows C:\Documents and Settings\All Users\Application 
Data\EFI\EFI eXpress\Log

Macintosh Users/<username>/Library/Logs/

Windows Program Files\EFI\EFI Media Profiles

Macintosh Macintosh HD/Library/Application Support/EFI/EFI 
Media Profiles
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EFI Support
If you run into difficulties while working with Fiery eXpress and you cannot find the solution 
in this manual, contact your reseller or distributor for technical assistance. To find the contact 
details for your region visit http://www.efi.com/support-and-downloads/product-support.

Make sure to provide the following information when contacting your reseller or distributor:

• Version name and release number of your software

• License information

• Printer model

• Operating system with version number

• Any additional hardware and software you may have installed (e.g. ISDN boards, virus 
scanners, etc.)

Online user forum
The online forum is open to all users of Fiery eXpress. It enables you to post questions related 
to any area of Fiery eXpress directly to members of the EFI team. Furthermore, it permits 
open discussion with other forum members and thus provides an ideal platform for 
communicating with other users. To register as a forum member visit our website at 
http://proofingforums.efi.com and click on the quick link “User Forum”.

Conventions
Cautions must be read carefully. They indicate important information which can help you 
prevent errors when using the software.

Tips and information which you may find useful to perform a certain step.

The screen captures illustrated in this manual have been created from a mixture of both the 
Windows and Macintosh versions of Fiery eXpress.

http://proofingforums.efi.com
http://proofingforums.efi.com
http://www.efi.com/support-and-downloads/product-support
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GETTING STARTED

This section describes how to license and set up your software. Normally, you will already 
have performed these steps as part of the installation procedure.

Starting Fiery eXpress
During installation, a program icon is created.

TO START FIERY EXPRESS

1 In Windows, double-click the program icon on the computer desktop. On Macintosh, click the 
program icon in the Dock.

The software runs in demo mode until licensed. In demo mode you can load and process jobs. 
However, all your printouts will be overlaid with a demo stamp. To output jobs without the 
demo stamp, you must license the software.

In demo mode, you have access to both Fiery eXpress for Photo and Fiery eXpress for 
Proofing. This enables you to switch between versions to see which product best suits your 
needs before installing a license. If a product selection window opens when you start 
Fiery eXpress, select which version you want to use.

Program icon
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The program window opens.

Product registration
Fiery eXpress is subject to a license management system.

During product registration, a license file is automatically generated and installed. If you try 
and run Fiery eXpress without a valid license, the software will work in demo mode only. This 
means that, although you will be able to load and process jobs, all your printouts will be 
overlaid with a demo stamp. To output jobs without the demo stamp, you must register.

EFI employs a hardware copy protection system to prevent unlawful copying of the software. 
It works by extracting a unique ID from the dongle provided with the software. The license 
file creates a fixed link between the software and the dongle.

Licensing Fiery eXpress
If you did not register during software installation, you can do it now.

You can license Fiery eXpress automatically or manually. Which method you use normally 
depends on whether the computer on which the software is installed has Internet access or 
not. To generate a license file, you require a computer with Internet access. If Fiery eXpress is 
installed on a computer without Internet access, you must generate the license file on a 
different computer and then install the license file manually.

Program window
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To create a license file, you are required to type in the EAC code printed inside the product 
packaging, so make sure you have this at hand.

It is a good idea to save your license file in a safe place, should you need to reinstall it at any 
time. Alternatively, you can download it again at any time from the activation website by re-
entering the EAC code.

Once a license file is installed, it is displayed in the status bar of Fiery eXpress. If no license is 
installed, Fiery eXpress indicates that the application is running in demo mode.

Before licensing, make sure that the dongle is plugged into a USB port on the computer. The 
dongle may take up to one minute to be detected.

TO LICENSE AUTOMATICALLY (REQUIRES INTERNET ACCESS)

1 From the Actions menu, choose Activation Wizard (Windows) or Activation Assistant 
(Macintosh).

2 Click the Automatically tab.

3 Enter the EAC code in the appropriate edit boxes and click Next Step to set up a connection to 
the EFI Activation Server.

The EAC code is case-sensitive.

4 Read carefully the information about product registration. Then click Next Step.

5 Fill out the online form with your user registration details.

If you have previously registered an EFI product, the form is filled out automatically if you 
type your e-mail address and click Retrieve.

Automatic license activation
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6 Click Install License.

A license file is created and downloaded to the Licensing folder on your computer.

If problems arise when tying to download a license file, go to the website 
http://activation.efi.com.

7 Click Finish to exit the Activation Wizard/Assistant.

TO LICENSE FIERY EXPRESS MANUALLY (WITHOUT INTERNET ACCESS)

1 From the Actions menu, choose Activation Wizard (Windows) or Activation Assistant 
(Macintosh).

2 Click the Manually tab.

3 Make a note of the displayed dongle ID or copy and paste the dongle ID into a text file by 
clicking Copy ID.

4 From a computer with Internet access, go to the website http://activation.efi.com and follow 
the on-screen instructions to generate and download a license file.

Make sure you have the following information handy:

• the dongle ID

• the Entitlement Access Code (EAC) printed inside the product packaging.

5 Copy the downloaded license file to a location on the computer on which Fiery eXpress is 
installed, e.g. the computer desktop.

6 In the Activation Wizard/Assistant, click Install License and browse to the downloaded 
license file.

Manual license activation

http://activation.efi.com
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7 Select the license and click Open.

The license file is copied to the Licensing folder.

8 Click Finish.

Setting up Fiery eXpress
It takes just a few easy steps to set up Fiery eXpress and start printing.

TO SET UP FIERY EXPRESS

1 From the Actions menu, choose Setup Wizard (Windows) or Setup Assistant (Macintosh).

Setup Wizard
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2 Click Continue.

3 In the Color Management dialog, from the drop-down list box, select the color management 
preset that best matches your needs.

Fiery eXpress provides predefined color management presets. Each preset is set up with 
default color management settings that help you get the best color quality for a particular type 
of workflow scenario.

If you are a novice, it is recommended that you start by using a default color management 
preset. As you become more experienced, you can experiment with the many different 
available color management settings and create your own presets.

Choose from the following:

• Proofing

This preset simulates the CMYK color gamut of a professional printing press. Choose this 
setting to predict the color output of a proper production run.

• Production

Use this preset for large-format prints, such as building wraps or signage.

Selecting a color management 
preset
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• Photo

This preset processes image data for output on the selected printer. It makes full use of the 
available color gamut of the output device, thus ensuring vivid color output in photo 
quality.

Choose this preset to print RGB images, such as photos.

To output color photos in black and white, use with the setting “Convert to Grayscale”.

• Business Graphics

This preset is ideal for printing presentations that call for bright, vivid colors.

• Convert to Grayscale

Use this preset to output color jobs as grayscale images. Five different shades of grayscale 
are available, ranging from a yellowish tint (warm black) to a bluish tint (cold black). See 
“Color management preset” on page 61 and “Convert to grayscale” on page 67 for further 
information.

• No Color Management

With this preset, no profiles are applied during job processing. As no color management 
takes place, the results represent the true color quality of your printer. This preset is 
necessary if you wish to create your own media profiles.

See “Color management preset” on page 61 for individual settings of each preset.

4 Click Continue.

Selecting a device type
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5 In the Printer Device dialog, from the drop-down list box, select your printing device.

In Fiery eXpress for Photo, an extra check box allows you to filter out CMYK printers from 
the list of available printers. This means that only RGB devices are available for selection.

Fiery eXpress displays the number of media profiles installed for the selected printer. If no 
media profiles are installed, you need to start the media profiles setup program from the 
software DVD.

6 Click Continue.

Setting up a printer connection



GETTING STARTED 22

7 In the Printer Connection dialog, select the type of printer connection.

• Select “Print to system printer” to print to a Windows printer that has already been set up 
as a system printer in Windows. The available printers are listed in the drop-down list box. 
This setting is only available for Windows.

• Select “Print via network” if you want to print via TCP/IP or Bonjour.

– For TCP/IP printing, type the IP address in the appropriate edit box. You can check 
whether the connection to the printer has been properly established by clicking Test. If 
you receive an error message, consult your system administrator for advice.

– For Bonjour printing, the name of the printer is displayed automatically.

Bonjour is a standard component of Macintosh OS X operating systems. To print to a 
network printer that supports the network protocol Bonjour, select the printer name 
like you would a locally connected printer. The IP address is automatically detected.

Windows users can download the Bonjour software from the Apple website at 
http://www.apple.com/support/downloads/bonjourforwindows.html.

• Select “Print via port” to print to a local printer connected via USB. The printer must be 
switched on when you start Fiery eXpress. Otherwise, it will not be automatically detected.

See Printer connection for further details.

8 Click Continue.

9 In the Media Set dialog, from the drop-down list box Ink type, select the type of ink inserted 
in the printer.

Selecting a media type
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10 From the drop-down list box “Media name”, select the media you want to use.

Fiery eXpress provides media profiles that have been created for specific combinations of 
media, ink and resolution. Furthermore, you can implement your own custom media profiles 
that have been created for your exact printer.

11 From the drop-down list box “Print quality”, select a combination of color mode, resolution 
and print mode.

The list of available print qualities depends on the media profiles that are installed.

12 Click Continue.

13 In the Media Size dialog, make media-specific settings.

Which settings are available depends on the selected printer.

• From the drop-down list box “Source”, select roll feed or an appropriate paper cassette or 
paper tray.

• From the drop-down list box “Format”, select the media size. You can also use the 
appropriate edit boxes to define a custom media size.

• If supported by your particular printer, you can select borderless printing.

Selecting a media format



GETTING STARTED 24

14 Click Continue.

15 In the Collection dialog, select a preset.

Fiery eXpress provides predefined collection presets. Each preset is set up with default layout 
settings. Select “None” if you prefer to create your own presets later.

16 Click Finish.

Your printer is now set up and you can print from Fiery eXpress.

See also: 

“An introduction to color management” on page 107

“Creating and implementing custom media profiles” on page 128

“Applying custom media formats” on page 132

Selecting a collection preset
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USER INTERFACE

Menus

Fiery eXpress menu (Macintosh only)

User interface
1 Menu bar
2 Toolbar
3 Button to open the 

Preferences dialog
4 Property Inspector
5 Job list
6 Preview window
7 Status bar

4

3

5

7

1
2

6

Fiery eXpress menu
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• About Fiery eXpress

Displays the version number of Fiery eXpress

• Preferences

Opens the Preferences dialog for making workflow settings.

• Hide Fiery eXpress

Minimizes the program window. To redisplay, click the program icon in the Dock.

• Quit Fiery eXpress

Closes Fiery eXpress.

File menu

• Import Job

Opens a window to enable you to browse to and select one or more jobs to be loaded.

• Delete Job

Deletes the selected job(s) from the job list.

• Save Changes

Saves the current settings.

• Print

Saves the current settings and starts printing the selected job(s).

• Preview

Saves the current settings (including those whose impact is not immediately visible in the 
preview) and updates the preview.

• Export to TIFF

Saves the selected job(s) to TIFF format instead of outputting it on a printer.

File menu
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• Cancel

Cancels job processing and printing.

• New Collection

Creates a collection of one or more jobs selected in the job list. A collection enables you to 
output any number of pages collectively as one single job.

• Refresh Collection

Displays a preview of a newly created collection or rearranges the pages of an existing 
collection after you have made changes.

• Add Job to Collection

Adds a new job to a selected collection.

• Move Job from Collection

Moves a selected job from a collection and places it as a single job in the job list.

• Reveal in Explorer (Windows)/Reveal in Finder (Macintosh)

Provides easy navigation to current job files and frequently used program folders.

• Exit (Windows only)

Closes Fiery eXpress.

See also: 

“TIFF Export tab” on page 48

“Preview window” on page 82

“Working with collections” on page 113

Edit menu
Edit menu



USER INTERFACE 28

• Cut

Removes a selected object.

• Copy

Copies text to the clipboard

• Paste

Inserts text from the clipboard.

• Scale

Scales one or more pages selected in the preview window. You can enlarge or reduce the 
page size by selecting a default percentage value. Alternatively, you can fit the page to 
media size, media width or media height. “Fit to Media Size” and “Fit to Media Height” 
are deactivated for roll media.

Scaling to media size enlarges the page to either the width or the height of the media, 
whichever is reached first. The page keeps its original proportions and scaling does not 
exceed the sheet format, i.e. no cropping takes place.

• Size

Displays all default scaling sizes available for the selected media, plus any user-defined sizes 
defined on the Page Layout pane.

• Rotate

Contains commands for rotating or mirroring a selected page. You can rotate by one of the 
default rotation angles or flip a page along its vertical or horizontal axis. If you select 
“Minimal Media Consumption”, Fiery eXpress automatically rotates pages, if applicable, 
to reduce media wastage.

• Align

Contains commands for positioning pages on the sheet. Vertical alignment (top, bottom, 
center) is not possible for roll media.

• Clone

Copies and pastes an exact copy of a selected page(s). This command can only be applied 
to pages in a collection.

• Remove Clone

Deletes the selected cloned pages. If the original page was also selected, it is not deleted.

• Use Page

Swops pages on a custom collection sheet. The swopped pages assume the position and 
layout settings of the page that they have replaced.
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• Order

Alters the order of overlapping pages in a collection. You can move a selected page to the 
front or back of the stack or move it up or down a level. This function can also be 
performed on multiple file selections.

• Align Edges

Defines an alignment for selected pages in a collection. Pages can be aligned according to 
their upper, lower, left or right edges or according to their vertical or horizontal centers.

• Distribute Edges

Distributes selected pages on a collection. Pages are rearranged evenly on the sheet so that 
their center points are equidistant from each other. You can distribute pages according to 
their upper, lower, left or right edges or according to their vertical or horizontal centers.

• Reset Page

Returns a selected page to its default settings.

See also: 

“Page Layout tab” on page 52

“Working with collections” on page 113

Actions menu

• Preferences

Opens the Preferences dialog for making workflow settings.

• Setup Wizard (Windows)/Setup Assistant (Macintosh)

Leads you step by step through the settings necessary to set up your output device for 
printing from Fiery eXpress. You can change the settings later in the Preferences dialog, if 
required.

• Activation Wizard (Windows)/Activation Assistant (Macintosh)

Leads you through the licensing steps necessary to activate Fiery eXpress. If you do not 
license the software, it will run in demo mode. This means that all your printouts will be 
overlaid with a demo stamp.

Actions menu
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• Clean Up

Deletes files that are no longer needed. You can choose to delete output files, preview files, 
temporary files, files loaded in the job list and log files. Alternatively, select “All”.

• Backup

Saves your individual workflow settings in EBK format. A dialog opens in which you are 
prompted to define a name and a location for the settings file.

• Restore

Reinstalls settings from a previously created backup file.

• Start Font Download

Converts Fiery eXpress to a low-res printer. This is necessary if you want to use Japanese 
fonts.

See also: 

“Product registration” on page 15

“Setting up Fiery eXpress” on page 18

“Backing up and restoring settings” on page 133

“Using Japanese fonts” on page 136

View menu

• Zoom In

Enlarges the size of the preview.

• Zoom Out

Reduces the size of the preview.

View menu
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• Fit to

Modifies the preview window as follows:

– Window

Scales the sheet to the height or width of the preview window, whichever is reached 
first.

– Selection

Scales one or more selected pages to the size of the preview window.

– Actual Size

Scales the sheet and all inserted pages to their real size.

• Go to

Scrolls through a multi-page job or a multi-sheet collection. You can scroll backward and 
forward a page or sheet at a time or proceed directly to the first or last page.

• Snap to

Aids precise page alignment. When this command is activated, guides, grid or objects 
receive a magnetic property which causes pages in their proximity to snap to them.

When “snap to objects” is selected, the collection setting for defining the amount of space 
between pages is observed.

• Visual Aids

Opens a submenu with commands to help you position your jobs:

– Rulers

Shows/hides the horizontal and vertical rulers. The system of measurement is defined 
by the setting made in the Preferences dialog.

– Guides

Shows/hides the guides you have positioned.

– Grid

Shows/hides grid. The grid consists of evenly spaced, non-printing horizontal and 
vertical lines. The grid spacing is fixed, but adapts automatically to the selected zoom 
factor.

– Page Frame

Shows the page borders. Use this feature to check if an object has a lot of white space 
around it which may be overlapping other pages on a collection.

– Overlaps

Indicates if pages are overlapping. Overlapping pages are indicated by a red frame.
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– Page Margins

Displays the non-printable margins as defined by the printer’s firmware.

– Collection Info

Shows/hides the following page information in a manual collection: coordinates, 
dimensions, ID number and clone details.

– Lock Guides

Fixes all guides in their current position.

– Clear Guides

Guides appear as non-printing lines and help you to layout pages in a collection. 
Choose this command to delete guides that you have previously placed.

You can also delete a guide by dragging it to the ruler. Drag horizontal guides to the 
horizontal ruler and vertical guides to the vertical ruler.

To place a guide, you must first display the rulers. From the View menu, choose Visual 
Aids. Then select Rulers and Guides from the submenu.

To create a horizontal guide, hold down the mouse button on the horizontal ruler and 
drag to the desired position on the sheet. To create a vertical guide, drag from the 
vertical ruler. Note that guides are not saved. When you exit Fiery eXpress, all guides 
are automatically deleted.

To move a guide, move the cursor over the guide until the x or y coordinate appears. 
Then, hold down the mouse button and drag the guide to a new position. It is not 
possible to move locked guides.

• Show/Hide Preview

Shows/hides the preview window. This command has a toggle effect.

• Show/Hide Job List

Shows/hides the job list. This command has a toggle effect.

• Show/Hide Properties

Shows/hides the Property Inspector. This command has a toggle effect.

• Show/Hide Main Toolbar

Shows/hides the toolbar. This command has a toggle effect.

• Show/Hide Preview Toolbar

Shows/hides the preview toolbar. This command has a toggle effect.

• Show/Hide Status Bar

Shows/hides the status bar. This command has a toggle effect.
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• Maximize Preview

Displays an enlarged view of the preview window by hiding the job list and Property 
Inspector. This command has a toggle effect.

• Full Screen

Maximizes the size of the Fiery eXpress program window by hiding the menu bar, the 
status bar and the Windows taskbar. To return to the original program view, click the Full 
Screen button in the preview toolbar or press <Ctrl>+<Shift>+<F> (Windows) or 
<Apple>+<Shift>+<F> (Macintosh).

See also: 

“Preview window” on page 82

Help menu

• Fiery eXpress Help

Starts the HTML online help for Fiery eXpress.

• EFI Product Website

Opens the EFI homepage.

• EFI Support Website

Opens the EFI Support website which contains information on how and where you can 
receive help in your region.

• Online Update

Opens a window in which you define whether and how often Fiery eXpress automatically 
searches for available program updates. You can also start the search manually.

• About (Windows only)

Opens a window with details of your program version.

See also: 

“Installing online program updates and profile updates” on page 134

Help menu
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Main toolbar
Import Job: 
Opens a window to enable you to browse and select one or more jobs to be loaded.

Delete Job: 
Deletes the selected job(s) from the job list.

Save Changes: 
Saves the current settings.

Process and Print: 
Saves the current settings and starts printing the selected job(s).

Calculate Preview: 
Saves the current settings (including those whose impact is not immediately visible in the 
preview) and updates the preview.

Export to TIFF File: 
Exports the selected job(s) to TIFF format in accordance with the settings defined on the 
TIFF Export tab.

Cancel Processing and Printing: 
Cancels job processing and printing.

New Collection: 
Creates a collection of one or more jobs selected in the job list. A collection enables you to 
output any number of jobs collectively as one single job.

Refresh Collection: 
Displays a preview of a newly created collection or rearranges and saves the pages of an 
existing collection after you have made changes.

Preferences: 
Opens the Preferences dialog for making workflow settings.

Setup Wizard (Windows)/Setup Assistant (Macintosh) 
Leads you step by step through the settings necessary to set up a workflow or to make changes 
to an existing one.

See also: 

“Preferences dialog and Property Inspector” on page 35

“TIFF Export tab” on page 48

“Forcing a preview” on page 86

“Working with collections” on page 113
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Preferences dialog and Property Inspector

Fiery eXpress differentiates between workflow settings and job settings. Workflow settings are 
made in the Preferences dialog and are applied to all jobs that are subsequently loaded in 
Fiery eXpress, whereas the settings you make in the Property Inspector are job-specific.

The first time you started Fiery eXpress after installation, a setup wizard or setup assistant 
helped you to define some basic workflow settings. You can change any of these settings in the 
Preferences dialog.

The settings available in the Preferences dialog and in the Property Inspector are almost 
identical. Unless otherwise stated, the settings can be made equally for the Fiery eXpress 
workflow or be applied at job level. 

Job-specific settings made in the Property Inspector override the workflow settings made in 
the Preferences dialog.

User interface
1 Preferences button
2 Property Inspector

2

1
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Accessing and making settings in the Preferences dialog
To access the Preferences dialog:

• In the toolbar, click Preferences or 

• From the Actions menu, choose Preferences 

• From the Actions menu, choose Setup Wizard/Assistant. The Setup Wizard Assistant leads 
you step by step through the basic printer and workflow settings.

Settings made in the Preferences dialog are applied to all jobs subsequently loaded in 
Fiery eXpress.

Reset 
Returns all settings made in the Preferences dialog to their default values.

Be aware of the implications of using this button.

Save 
Saves all settings made in the Preferences dialog in EPF format. A dialog opens in which you 
are prompted to define a name and a location for the settings file. Setting files provide a quick 
and easy way to switch between two different printer setups.

An EPF file saves only the current settings from the Preferences dialog. It does not save created 
media profiles, spot color tables or visual correction files, etc. To save these files as well you 
must create a backup file.

Load 
Restores settings from a previously saved EPF file. Browse to the location of the settings file, 
select the EPF file and click Open. Setting files provide a quick and easy way to switch 
between two different printer setups.

It is important to ensure that all the necessary files (media profiles, linearization files, etc.) are 
available when restoring preferences. If any files are missing, an error message is displayed 
when you try and load the settings file.

Cancel 
Closes the Preferences dialog without saving changes.

OK 
Saves new settings and closes the Preferences dialog. The new settings are applied to all jobs 
you subsequently load. 

To apply new settings to jobs already loaded, either delete and reimport the jobs or make job-
specific settings in the Property Inspector.

See also: 

“Settings” on page 37

“Backing up and restoring settings” on page 133
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Accessing and making settings in the Property Inspector
The Property Inspector is displayed on the right of the program window. It displays the 
settings that are currently applied to a selected job.

When you have finished making changes, click Save to apply the new settings.

Settings
Both the Preferences dialog and the Property Inspector are divided into four sections. You 
access the settings for each section by clicking the appropriate button at the top of the 
Preferences dialog or Property Inspector.

Fiery eXpress differentiates between basic and additional settings. The basic mode contains a 
minimum of settings necessary to achieve a good print result. For users who want to have 
more control over the appearance of their job output, additional settings are available. The 
additional settings are displayed by selecting the check box “More options” at the bottom of 
the Preferences dialog or in the Property Inspector.

If you change a setting in “More options” and then hide it by deselecting the “More options” 
check box, the setting will still be saved.

1 Preferences dialog
2 Property Inspector
3 Check box for displaying 

additional settings

1
2

3

3
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The following sections describe all the settings available in Fiery eXpress for Proofing. The 
table below provides a summary of the reduced set of features in Fiery eXpress for Photo.

General (Preferences dialog only)

Application tab

Feature/Setting Comment

Spot color simulation Not supported

Control strips/Fogra media wedges Not supported

Use size out of the Not possible to apply media box, crop box, bleed box, 
art box or trim box information

Print engine No choice of Adobe PDF Print Engine (APPE) or 
CPSI available

Job list Fewer default column headings

Application tab
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• Country settings

– Language

This setting lets you choose the language in which Fiery eXpress is displayed. Select the 
language of your choice from the drop-down list box. If you select Automatic, 
Fiery eXpress is displayed in the language of the installed operating system.

– Units

Fiery eXpress supports the following units of measurement: millimeter, centimeter, 
meter, inch and foot. Select the unit of your choice from the drop-down list box.

• Product selection (More options)

These settings are only available if you are using an unlicensed version of Fiery eXpress. In 
demo mode you can load and process jobs. However, all your printouts will be overlaid 
with a demo stamp. To output jobs without the demo stamp, you must license the 
software.

– Product type

Fiery eXpress is available in two different versions. Users of Fiery eXpress for Proofing 
have access to the full set of program features, whereas users of Fiery eXpress for Photo 
can access only those settings required in a photo environment.

By selecting a program version from the drop-down list box, you can display the 
settings for either a proofing or a photo workflow.

– Show Product Selection dialog at application start

By default, you are asked to select a product version each time you start Fiery eXpress. 
Deselect the check box if you do not want the dialog to be automatically displayed.

• Work folder (More options)

All temporary and output files created during job processing are saved to a work folder. 
This folder contains subfolders, which Fiery eXpress uses during job processing.

If you do not want to use the default folder, you can define a custom folder by clicking 
Choose and browsing to the required folder. Note that users must have write permissions 
to the work folder in order to process jobs.

After defining a new work folder, you must exit and restart Fiery eXpress. During this 
process, subfolders are copied from the default work folder. This may take a while if the 
default work folder already contains job files.

Do not delete the default work folder. It contains some subfolders which are still used by 
Fiery eXpress.

• License folder

By default, license files are copied to the Licensing folder when you activate the software. If 
you do not want to use the default folder, you can define a custom folder by clicking 
Choose and browsing to a different location.
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• Monitor Profile (More options)

Fiery eXpress enables you to verify color accuracy on a computer screen. This is known as 
"soft proofing". However, much like the color output of each printer can vary greatly, so 
each monitor displays color slightly differently. To overcome this problem, it is important 
that the monitor is regularly calibrated to a certain standard. Monitor calibration consists 
of two steps:

– Adjusting the brightness and control settings on the monitor itself to set values

– Creating a monitor profile, which defines the white point, gamma and RGB phosphor 
settings

Fiery eXpress provides a default generic RGB profile which you can apply by selecting the 
appropriate radio button.

In addition, Windows and Macintosh computers provide standard monitor profiles as part 
of the operating system. The name of the standard monitor profile is displayed in 
parentheses after the system monitor profile setting.

You can also apply a custom monitor profile by clicking Custom profile and browsing to 
the required location. To use a different custom monitor profile from one previously 
selected, click Choose and browse to the new profile.

See also: 

“Fiery eXpress folder” on page 10

“Product registration” on page 15
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Workflow tab

• File processing

– Collect incoming files automatically after 

Select the check box and define a period of time after which Fiery eXpress 
automatically starts processing a collection. Files are collected immediately but job 
processing does not commence until the defined time period has elapsed.

– Print jobs automatically 

Select the check box if jobs should be output automatically as soon as they are loaded.

Be aware that this setting does not let you make job-specific settings. To make job-
specific settings you must cancel job processing.

– Calculte page size

Select the check box to instruct Fiery eXpress to calculate the page size. This is done by 
RIPping the whole document at a low resolution. It is slower than extracting the page 
size from the bounding box but produces more accurate results. This setting helps to 
prevent image distortion when printing from some graphics applications.

Workflow tab
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– Use size out of the (More options)

You can specify which PDF setting is applied to calculate the page size.

“

Media box Describes the size of the output media and is displayed in the print 
dialog. All the other boxes are smaller and are found inside the 
media box.

Crop box defines the region to which the contents of the page are to be 
clipped (or cropped) when displayed or printed. Unlike the other 
boxes, the crop box has no defined meaning in terms of physical 
page geometry or intended use. It merely suggests where the page 
should be clipped.

Bleed box Defines the bounds to which the contents of the page should be 
clipped when output in a production environment.

ArtBox Defines the meaningful content of the page, including potential 
white space.

Trim box defines the intended dimensions of the finished page after 
trimming. This type of box is used by imposition applications for 
arranging the order of pages.

PDF boxes
1 Media box
2 Bleed box
3 Trim box
4 ArtBox

1

2

3

4
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• Print engine (More options)

– PDF print engine

By default, print jobs are processed using the Adobe PostScript 3 Engine (also known as 
Configurable PostScript Interpreter or CPSI). It is able to process PostScript level 3 and 
PDF files. During job processing, source files are converted to PostScript format.

If your job is in PDF format, you can choose "Adobe PDF Print Engine" (also known 
as APPE). This setting processes PDF files without converting them first to PostScript. 
APPE has the advantage that it is able to process any number of PDFs simultaneously.

APPE can only process 32 separations, whereas CPSI supports up to 255. If more than 
32 separations are detected in a job, CPSI is automatically used.

– Image EPS/PDF print engine

The setting "Native" recognizes native EPS and PDF Photoshop files, allowing the 
pixel data to be processed directly instead of being interpreted by the CPSI PostScript 
interpreter. This results is a quicker processing time and better output quality since the 
Photoshop pixel data can be accessed directly.

The setting "Adobe PostScript 3 Engine" specifies that the image file is processed by 
CPSI instead of by the native plug-in which recognizes Photoshop files directly.This 
setting is automatically applied if the job contains more than one PDF image.

• Preview settings (More options)

Select the check box “Create preview when loading job” to create a preview of your jobs 
before job processing starts. Preview images appear in the preview window and in the job 
list.

The preview window displays the contents of a job selected in the job list. You can 
stipulate the display resolution of these previews in dpi or pixel by selecting the 
appropriate radio button.

The job list displays thumbnail images of all loaded jobs. You can determine the size of 
thumbnail images via the drop-down list box “Job list preview size”.
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• File deletion (More options)

– Print/preview files

During job processing, Fiery eXpress creates a print file of each job and saves it to the 
Output folder. If the preview setting is selected, a preview file is also saved to the 
Preview folder.

Use the drop-down list box to choose when these files are deleted. They can be deleted 
automatically after printing or after the number of days you specify in the edit box. To 
retain print and preview files, select “Never” from the drop-down list box to ensure that 
they are not deleted.

If you have previously made a setting to delete source files, the same setting is 
automatically applied to output/preview files. An independent setting is only possible if 
you have specified that source files are never to be deleted.

– Source files

Source files, e.g. files in the job list, can be deleted automatically after printing or after 
the number of days you specify in the edit box. If you would rather preserve source 
files, select “Never” from the drop-down list box to ensure that they are not deleted.

Jobs are loaded in Fiery eXpress by creating a link to the original file. When source files 
are deleted, only those files saved to the JobFolder are deleted, not the original file.

Any setting you make for source file deletion is automatically applied to output/
preview files. It is not possible to delete source files alone.

The default hotfolder is also the default spool folder. Therefore, files copied to the 
default hotfolder are automatically deleted with source files. To delete source files 
without deleting files placed in the hotfolder, define a new hotfolder location.

– Delete source files from hotfolder

Select this check box to delete job files copied to a hotfolder.

See also: 

“Fiery eXpress folder” on page 10

“Printing via a hotfolder” on page 93

“Preview window” on page 82

“Working with collections” on page 113
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Job Detection tab

• Job detection

– Activate hotfolder

A hotfolder enables users, who do not have Fiery eXpress installed on their computers, 
to copy jobs to a centrally located folder on the network or local hard drive. You must 
define a hotfolder if you want to print to Fiery eXpress as a virtual printer.

– Hotfolder path

After you have selected “Activate hotfolder,” click Choose to browse to the folder you 
wish to use as a hotfolder. A hotfolder can be located anywhere on the network or local 
hard drive.

• Spooler (More options)

This setting sets up a virtual printer for the workflow. It can be selected from the print 
dialog of any application and thus enables users to print directly to Fiery eXpress

To set up a virtual printer, select the check box “Activate virtual printer” and define a name 
in the edit box. This is the name that will be displayed in the printer list of the application.

Job detection tab
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• AppleTalk spooler (More options)

Select the check box “Activate AppleTalk spooler” and define an AppleTalk spooler name 
to print directly to Fiery eXpress from a Macintosh application using the PPD provided on 
the software DVD.

By default, this setting is dimmed on Windows XP and Windows Vista computers because 
these operating systems do not support AppleTalk. However, a special EFI AppleTalk 
driver is provided with Fiery eXpress to enable AppleTalk printing from Windows XP.

On Macintosh, make sure that AppleTalk is active in Network of System Preferences.

• Unidriver

Select the check box “Allow Unidriver to send jobs” to enable users to submit jobs to your 
Fiery eXpress installation via Unidriver. By removing the check mark, you can prevent 
users from logging on to your installation of Fiery eXpress and submitting print jobs.

See also: 

“Printing via Unidriver” on page 89

“Printing via a hotfolder” on page 93

“Virtual printing” on page 94

“Setting up AppleTalk for Windows XP” on page 97

Speed tab

Speed tab
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• Speed

– Bi-directional, if supported by selected output device

If your printer supports bi-directional printing, selecting this check box can help 
increase print speed. Bi-directional printing is faster than unidirectional printing, as the 
print head prints in both directions, but may provide less accurate results.

– RIP and print on the fly

Select this check box if you want your jobs to start printing as soon as processing starts. 
If this check box is not selected, printing will not commence until job processing has 
been fully completed.

Simultaneous processing and printing may cause the printer to pause from time to 
time. This can lead to undesirable stripes on the printout.

• Processsing resolution (More options)

Use the slidebar to define whether speed or quality is the more important factor during 
processing. By reducing the resolution at which the job is processed you increase the speed 
of output. However:

– Processing a job at a low resolution may result in a draft-quality output, whereas 
printing at a high resolution setting will take longer.

– It is not possible to process a job at a higher resolution than the output resolution.

– If the Japanese font option is installed, the RIP resolution of PostScript-based files is 
restricted to 1200 dpi if you are using low-res fonts.
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TIFF Export tab

On this tab, you define the settings for printing image files to TIFF format as opposed to 
outputting them on a printer. By selecting appropriate source profiles, you can reliably check 
the color quality of your images before forwarding the TIFF file to, for example, your 
advertising agency for further processing.

If your workflow is set up to start printing automatically as soon as a job is loaded, the job will 
be processed. To overcome the problem, you can either deactivate automatic printing on the 
Workflow tab or cancel job processing.

• Export to TIFF

If you do not want to save TIFF files to the default folder, click Choose and browse to an 
alternative location.

• Profile (More options)

Select a profile to apply and save to TIFF with the image.

TIFF export tab
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• Compression (More options)

Select a compression method from the drop-down list box. You can choose between:

– None

This method rules out the possibility of data loss when the file is extracted but, 
depending on the size of your image data, it may make it necessary to transfer large 
volumes of data.

– PACKBITS

Packbits is a particular type of run-length compression. It is an effective way to reduce 
the size of image files which contain large areas of solid color without any loss of data.

However, you should be aware that this method of compression is unsuitable for use 
with images that do not consist of large areas of solid color and may even result in an 
increased file size.

– ZIP

This method compresses your data and enables it to be extracted in its original form 
without data loss.

• Resolution options (More options)

– Keep input resolution

Occasionally, Fiery eXpress has difficulty correctly extracting and interpreting the 
resolution of incoming PS and PDF files. Rounding down errors may occur due to 
internal processing in Fiery eXpress. This can cause a white edge to be output along the 
right and bottom edges of images, the result of missing pixels. Applying the input 
resolution size from the image helps to prevent rounding off errors.

– Resolution

Define an output resolution between 18 and 2500 dpi. However, be aware that 
increasing the resolution increases the volume of data.

• Size options (More options)

The size options enable you to define an output width or height for your TIFF files. If you 
define a width, the image height is automatically scaled proportionally and vice versa. If 
you want your jobs to be saved with exactly the same dimensions as the source file, select 
“Keep input size”.

See also: 

“Main toolbar” on page 34
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Info tab (Property Inspector only)

• File Info

Displays the name, location and creation date of loaded files.

If a photographic image contains metadata tags defined in the Exif standard, this is also 
displayed. Exif data gives details of the camera model and the camera settings used to take 
the photo.

Info tab
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If GPS data with valid GPS coordinates is also saved to the image file, the location is 
displayed on a small map of the world, together with city and country names, and the Exif 
information turns into a hyperlink. Clicking on the hyperlink opens your browser to show 
the location in Google maps. Fiery eXpress does not have to be installed on a computer 
with Internet to look up the city and country names. See “Footer tab” on page 59 for 
making Exif settings.

• Original

Displays the physical dimensions of a job, its resolution, color space and whether it is 
composite/separated.

• Information and Warnings

Displays information and warnings pertinent to the currently selected job.

• Error

Displays the cause of an error that has occurred during job processing.

Info tab with GPS data
1 Location on world map
2 Location in Google maps

1
2
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Layout

Page Layout tab

• Scale

The following scaling options are available from the drop-down list box:

– No Scaling

Jobs are printed in their original size. A warning message is displayed on the Info tab if 
you try and print a page that will not fit fully on the media.

– Fit to Media Size

Jobs are scaled so that either the height or the width (whichever is reached first) is 
adjusted to the printable height or width of the media. This setting is not available for 
roll media.

– Fit to Media Width

Jobs are scaled horizontally so that the width is adjusted to the printable width of the 
media. However, this may mean that the height is clipped. Check the preview to see the 
effect of this setting and make sure that jobs fit properly on the selected media size.

Page Layout tab
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– Fit to Media Height

Jobs are scaled vertically so that the height is adjusted to the printable height of the 
media. However, this may mean that the width is clipped. Check the preview to see the 
effect this setting and make sure that jobs fit properly on the selected media size. This 
setting is not available for roll media.

– Scale Percentually

Here you can define an enlargement or reduction factor. A value of more than 100 
increases the page size, whereas a value of less than 100 decreases it.

To scale percentually, select “Scale percentually” and then define the scaling factor. 
Predefined scaling factors of between 10% and 500% are available further down the 
drop-down list box. Alternatively, type the required scaling percentage in the 
appropriate edit box. The scaling factor is applied to both width and height.

– Scale Numerically

Here you can define a new height or width for your jobs. If you change one dimension, 
the other is automatically changed in proportion. You cannot use this setting to distort 
the proportions of a job.

To scale numerically, select “Scale numerically” and then define the required page 
dimensions. Predefined page dimensions are available further down the drop-down list 
box. Alternatively, type the required page dimensions in the appropriate edit boxes and 
save as a preset by clicking the plus (+) button.

Numerically defined scaling factors saved as a preset can be applied to pages in a 
collection to create a contact sheet.

• Rotate

Rotates your jobs for output. Rotation angles of 90°, 180° and 270° are available. If you 
select “Minimal Media Consumption”, Fiery eXpress automatically rotates your pages, if 
applicable, to keep media wastage to a minimum.

• Mirror Horizontally/Vertically (More options)

Flips a page along its vertical and/or horizontal axis.

• Crop (More options)

Enables you to crop the edges of a page by defining top, bottom, left or right margins.
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• Align (More options)

This setting positions pages on the media. It is applied relative to the edges of the media. 
Pages can be aligned horizontally (left, right, centered) or aligned vertically (top, bottom, 
centered). In addition, horizontal and vertical margin settings are available to enable more 
precise page positioning.

The printer’s non-printable area is visible in the preview window. By defining appropriate 
margins you can ensure that pages are not inadvertently cropped during printing due to 
printer limitations.

The alignment settings work in conjunction with the scale settings on this tab. As an 
example, horizontal page alignment is not possible if “Fit to Media Width” is applied. 
Similarly, all alignment settings are dimmed if you have specified “Fit to Media Size”.

Collection tab

Collections enable you to output any number of pages as one single job. 

Collection tab
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• Collection preset

Fiery eXpress provides a number of predefined collection presets. Alternatively, you can 
design your own collection layouts and save them as a preset to apply to future jobs. The 
following can be saved in a collection preset:

– All settings made on the Page Layout, Collection, Marks and Footer tabs

The only exception is job rotation. Here, the orientation settings from the Collection 
tab are applied instead.

– All clone settings

– Page transformations and page position on the sheet. This applies to collection presets 
created from manual collections in Property Inspector only.

When you have finished making settings, click the plus (+) button and give your preset a 
unique name. The next time you create a collection and select the preset, the settings are 
automatically applied.

If you create a preset for a fixed number of pages and apply this preset to a collection that 
consists of more than this fixed number, a second sheet is automatically created.

• Collection layout

– Optimization

With the “Optimization” settings you define the layout of pages on the sheet. Pages can 
be positioned to use as little space as possible on the sheet or aligned so that, when 
printed, they can be cut out using as few straight horizontal or vertical cuts as possible.

– Orientation

Via the drop-down list box “Orientation” you can define landscape or portrait output 
for all pages. “Automatic” rotates the pages if necessary in order to keep media 
consumption to a minimum.

– Automatic layout

With this setting pages are positioned on the sheet according to the defined 
optimization and orientation settings.

The check box “Transform collection elements” enables you to apply a uniform scaling 
setting to all collected pages. Note that activating this check box undoes any scaling 
settings previously made on the Page Layout tab for individual pages. Cropping and 
mirror settings are not affected.
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“Scale proportionally” scales jobs to a uniform size. For photographers, this setting 
provides an easy way to create a contact sheet. The drop-down list box provides a list of 
default page sizes, plus any custom sizes. You can create custom sizes on this tab by 
typing a width and height in the appropriate edit boxes and clicking the plus (+) 
button.

The setting “Full sheet without cropping” scales each page to the full width or height of 
the sheet, whichever comes first. This leaves a white margin along one edge. Selecting 
“Full sheet with cropping” overcomes this problem by increasing the scaling factor to 
remove all white space. It means that the image is cropped by an equal margin width 
either top and bottom or left and right. This setting is not available for roll media.

Example of proportional 
scaling

Full Sheet setting (with 
activated automatic 
orientation)
1 No page scaling
2 Full Sheet without cutting
3 Full Sheet with cutting

1 2 3
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With “Pages per sheet” (available if you select “More options”), pages are scaled by the 
maximum factor possible in order to fit the specified number of pages onto the sheet. If 
pages have a footer, this is taken into account. This setting is not available for roll 
media.

– Manual layout

This setting enables you to arrange loaded jobs in the preview and save the custom 
layout as a preset. Job position, transformations and clone settings are also saved to the 
preset and applied to future collections.

Transforming any page on a collection sheet automatically turns an automatic 
collection into a manual layout. If you click the Refresh button, all transformations are 
undone and the automatic collection layout is reapplied.

• Spacing

– Between collection elements

Here you define the amount of space between collected pages. Type the required 
horizontal and vertical values in the edit boxes.

– Around collection (printer margin is minimum)

Here you define a paper-white margin around the collection to simulate a picture 
mount. This setting takes into account the non-printable area. Type the required values 
in the edit boxes.

See also: 

“Working with collections” on page 113

Examples of 1, 3 and 8 pages 
per sheet
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Marks tab

You can output crop marks around a single page or around a collection. by selecting the 
appropriate tab.

• Crop marks

Different types of crop marks are available for selection from the drop-down list box.

• Crop mark options (More options)

These settings are enabled when you select a crop mark type.

You can define the thickness, length and distance to job for each type of crop mark.

Furthermore, you can reposition the crop marks in relation to the page using the bleed 
settings. By typing a positive value in the edit box, you add white space between pages and 
crop marks. Type a negative value to crop each edge of the page by the defined margin 
width, e.g. to eliminate unwanted paper white or to reduce the size of a page.

The setting “Distance to job” is also taken into account when you apply this setting. For 
example, if you set crop marks at a distance of 10 mm to the job and define a bleed setting 
also of 10 mm, the crop marks will be positioned 20 mm from the page.

Marks tab

Bleed setting
1 Positive value
2 Negative value 1 2



USER INTERFACE 59

Footer tab

You can output a control strip and/or a job ticket for a single page or for a collection. In a 
collection, control strips and job tickets can be displayed for each collected page but the same 
footer information is applied to all elements.

If you select a rendering intent with paper white simulation, it is also applied to the job ticket 
and control strip.

When printing to file, job tickets and control strips are not exported to TIFF format.

• Control strip

A control strip consists of one or more rows of different color patches which are measured 
using a spectrophotometer, a special type of measuring device for obtaining color values.

You can use one of the control strips provided with Fiery eXpress or a control strip of your 
choice. Control strips must be located in the ControlStrip folder. Fiery eXpress can process 
all supported file formats except separated files; there is no size restriction.

In the Preferences dialog, clicking the right arrow (>) button opens the folder in which the 
control strips are saved.

Some printing shops or agencies use their own control strips for quality-assurance 
purposes. EFI provides a service for creating customized control strips. Contact proofing-
support@efi.com for further information.

Footer tab
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• Job ticket

A job ticket contains information pertinent to the job.

– ISO compliant (12647-7/8)

If you select this setting, the job ticket automatically contains information about the 
file name and the date and time of print, plus color and printer-specific information.

– Exif

Fiery eXpress is able to process Exif data saved to your photographic images. If you 
select this setting, the default Exif data is included in the job ticket. See also “Info tab 
(Property Inspector only)” on page 50 for information on displaying GPS data.

– Custom

If you select “Custom”, you can specify which Exif settings to include in the job ticket 
or deselect the settings for file name and date and time of print.

The preview displays a default job ticket. However, the full job ticket information is visible 
on the printout.

• Job ticket options (More options)

You can add your own text or an image, such as a company logo, to the job ticket 
information.

There is no restriction to the length of custom text. Font sizes from 4 pt to 72 pt are 
possible.

Images must be in JPEG or TIFF format and must not exceed 5 x 5 cm in size. Smaller 
images are automatically scaled to these dimensions. To add an image, click Choose and 
browse to the required image file. The logo is displayed to the left of the job ticket and 
control strip.

When you add an image, a copy of the file is automatically created in the Logo folder. You 
can remove a selected image from the job ticket by clicking the minus (-) button. This 
deletes the image from the Logo folder.

In the Preferences dialog, clicking the right arrow (>) button opens the folder in which the 
logo files are saved.

The default distance from job ticket to job is 5 mm or 0.197 inches. You can widen or 
narrow this gap by typing the required distance in the combo box. Settings in the range 0 
to 1000 mm (39.37 inches) are possible.

See also: 

“Collection tab” on page 54

“Positioning crop marks” on page 121
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Color

Management tab

The settings you make on this tab directly affect the color reproduction of your jobs. The 
preset drop-down list box contains a number of predefined settings. Each of the available 
presets is designed for a specific workflow scenario.

• Color management preset

Fiery eXpress provides a number of predefined color management presets. Each preset is 
set up with default color management settings that are designed to help you get the best 
color quality for a particular type of workflow scenario.

If you are a novice to color management, it is recommended that you start by using a 
default color management preset. As you become more experienced, you can experiment 
with the many different available color management settings and create your own presets.

Management tab



USER INTERFACE 62

The following default color management presets are available:

– Proofing

– Production

– Photo

Setting Option

CMYK ISOcoated_v2_.icc with Absolute colorimetric

RGB AdobeRGB1998.icc with Perceptual

Grayscale EFI Gray Profile.icc with Relative colorimetric

Multicolor None with Relative colorimetric

Working color space CMYK

Use embedded profiles No

Setting Option

CMYK ISOcoated_v2_.icc with Perceptual

RGB AdobeRGB1998.icc with Perceptual

Graycale EFI Gray Profile.icc with Perceptual

Multicolor None with Relative colorimetric

Working color space CMYK

Use embedded profiles No

Setting Option

CMYK ISOcoated_v2_.icc with Perceptual

RGB AdobeRGB1998.icc with Perceptual

Grayscale EFI Gray Profile.icc with Perceptual

Multicolor None with Relative colorimetric

Working color space RGB

Use embedded profiles Yes
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– Business Graphics

– Convert to Grayscale

– No Color Management

All settings are grayed out.

You can also create your own color management presets consisting of any combination of 
settings on this tab. Make the required settings and then click the plus (+) button. In the 
dialog, type a name for your preset and click OK.

It is not possible to overwrite or delete the default presets. If you inadvertently type the 
name of a default preset, Fiery eXpress displays a warning message. If you do not define a 
unique name, Fiery eXpress automatically saves the new preset as a copy of the original 
preset name. Similarly, it is not possible to delete the default presets.

Setting Option

CMYK ISOcoated_v2_.icc with Saturated

RGB AdobeRGB1998.icc with Saturated

Grayscale EFI Gray Profile.icc with Saturated

Multicolor None with Saturated

Working color space RGB

Use embedded profiles No

Setting Option

CMYK ISOcoated_v2_.icc with Relative colorimetric

RGB AdobeRGB1998.icc with Perceptual

Grayscale EFI Gray Profile-.icc with Relative colorimetric

Multicolor None with Relative colorimetric

Working color space CMYK

Use embedded profiles No

Convert to Grayscale Neutral
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• Source profile

Fiery eXpress provides many different source profiles. Source profiles describe the colors 
contained in your jobs — independent of the printer. Since Fiery eXpress takes the color 
definitions of the source profile and matches them to the media profile (your printer), you 
can influence color output by changing the source profile.

You can apply a source profile provided with Fiery eXpress or one supplied with your input 
device. Source profiles must be copied to the Reference Profiles folder, otherwise they 
cannot be detected.

– CMYK/RGB/Grayscale/Multicolor

Click on the tab that represents the input color space of your job and select a source 
profile from the drop-down list box.

The setting "Full Gamut” on the CMYK tab results in printouts that fully utilize the 
color gamut of the printer. The output colors are extremely saturated. Since the classic 
match of source profile to media profile is by-passed, the color characteristics defined in 
the source profile are not applied.

On the Multicolor tab, you can load your own 6- or 7-color profile. Generic multicolor 
profiles are not provided with the software.

– Rendering Intent 

Select a rendering intent from the drop-down list box.

• Use embedded profiles, if available

In a job comprising different pages, each page will automatically be processed using the 
embedded profiles. This setting is only applied to:

– TIFF, JPEG. It is not suitable for PS files.

– PDF/X-3 simulation profiles (output intent)

The following table illustrates how you can affect your color output with this setting:

Source file Use embedded 
profiles, if available 
is selected

Behavior in Fiery eXpress

TIFF file with an 
embedded sRGB profile.

Yes The sRGB profile is applied as the 
source profile. The source profiles 
selected on this tab have no effect.

No The source profiles selected on this 
tab are applied.

TIFF file with no 
embedded profile

n/a The source profiles selected on this 
tab are applied. The setting “Use 
embedded profiles, if available” has 
no effect.
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• Simulation profile

By applying a simulation profile and an appropriate rendering intent you simulate how 
your printout would look if output on a particular printing press.

You can load a simulation profile provided with Fiery eXpress or one supplied, for 
example, by your printing house. To use your own simulation profile, you must copy it to 
the Reference folder.

EFI provides a number of additional profiles, which you may find useful. You will find 
these in subfolders of the Reference Additional folder. To use an additional profile, copy it 
to the Reference Profiles folder. Only profiles located in the Reference Profiles folder can 
be selected in Fiery eXpress.

• Use PDF output intent, if available

This setting ensures that if an output intent is embedded in a PDF/X-3 file, it will be 
applied as a simulation profile.

This setting only has an effect on PDF and PostScript files.

Output intent in PDF/X-3 files

Option On/Off Description

Use PDF output 
intent

On PDF, PostScript: The available output intent is applied; 
the selected simulation profile is ignored.

Use PDF output 
intent

Off PDF, PostScript: The selected simulation profile is 
applied. If no simulation profile is selected, depending 
on the working color space of the RIP, the selected 
source profile is applied. (See “Working color space” on 
page 66).
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• Media input options (More options)

– Use black ink only

Specifies that any objects that have been defined as pure black are printed using black 
ink only. If you choose “Text and Images” from the drop-down list box, all dots with at 
least 1% K are printed using black ink only. Selecting “Text” means that only dots 
composed of at least 99% K are printed using black ink only. The setting “Never” 
ensures that black areas are composed of the available CMYK inks.

– Print RGB objects

Establishes whether a job contains RGB images. If RGB data is detected, the images 
can be printed in color, in grayscales or in a vivid shade of orange, depending on which 
setting you choose from the drop-down list box.

– Working color space

Here you define a color mode for your input data. For example, if you have a PDF or 
PostScript file composed mainly of RGB images, select “RGB”. In this case, the selected 
RGB source profile is automatically applied to the entire PDF.

Effect of selecting the RGB 
working color space

Effect of selecting the CMYK 
working color space
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• Media output options (More options)

– L*a*b* optimization

L*a*b* optimization files provide more precise printer adjustment. You can use an 
optimization file you have created in EFI XF by copying it to the Profiles folder. Only 
3cc files copied to the Profiles folder are available for selection from this drop-down list 
box.

In the Preferences dialog, clicking the right arrow (>) button opens the folder in which 
the L*a*b* optimization files are saved.

– Convert to grayscale

This setting lets you define the shade of grayscale output without applying the L*a*b* 
optimization files provided. Five different steps are available — from a yellowish tint 
(warm black) to a bluish tint (cold black). Select the check box and move the slider bar 
to the required position.

See also: 

“Setting up Fiery eXpress” on page 18

“An introduction to color management” on page 107

Gray variations
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Spot colors tab

• Color separation

– In-RIP separation

If your job already contains RIP settings from an external DTP program, you can 
choose whether these will be applied.

Select “Disable” to print all composite or in-RIP separated jobs as composite files. 
Separated files are still processed as separated.

Select “Enable” to apply all available in-RIP information to jobs. If no such 
information is detected in the job, files are automatically output as composite. 
PostScript files must contain not only details about color separations (process colors 
and spot colors), they also require start code information. This start code may be 
missing from PostScript files created by certain types of DTP programs. In this case, 
the in-RIP information cannot be properly interpreted and the file is output as 
composite.

If you select “Force”, all files are processed as separated files.

Spot colors tab
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– Simulate overprinting in composite jobs

Here you can determine whether overprint settings defined in the graphics application 
are applied during printing. Normally, when two objects of different colors overlap, 
there is a knock-out effect, i.e. they will not print on top of each other. Intentionally 
printing one layer of ink on top of another is known as overprinting. Overprinting is 
sometimes used to prevent gaps between adjoining colors.

This setting lets you simulate overprinting in composite jobs. This would otherwise not 
be possible, since overprinting is not supported by composite jobs.

By selecting the check box and saving and then examining the preview, you can check 
the behavior of possible overprint settings before printing.

This setting has no effect on jobs with in-RIP separation or on separated jobs.

• Unknown spot colors (More options)

Select the check box “Replace unknown spot colors with warning color” if you want to 
output undefined spot colors in a distinctive shade of green. This makes them immediately 
recognizable in the printout. Alternatively, you can define your own distinctive warning 
color by typing CMYK values in the appropriate edit boxes.

• Spot color preset

Select a spot color preset from the drop-down list box. To create a new spot color preset, 
make your settings on this tab and click the plus (+) button.

In the Preferences dialog, clicking the right arrow (>) button opens the folder in which the 
bct spot color files are saved. You can copy bct files to Fiery eXpress installations on other 
computers. This provides an easy way to replicate settings.

Overprinting
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• Spot color definitions (More options)

Fiery eXpress automatically detects whether a loaded job contains spot colors and displays 
them in the table in Property Inspector. Spot colors that have previously been defined in 
Fiery eXpress and saved as a spot color preset are displayed with their name, color space 
and color values. Spot colors that have not been defined are displayed as “Unknown”.

To process a job with unknown spot colors, you must either:

– define and save the spot colors as a spot color preset or

– select the check box and specify a replacement color

See also: 

“Working with spot colors” on page 122

Adjustment tab

The settings on this tab affect the color reproduction of the jobs you load in Fiery eXpress. 
Color adjustments are not applied to control strips.

• Color adjustment preset

Select a color adjustment preset from the drop-down list box. To create a new color 
adjustment preset, make your settings on this tab and click the plus (+) button.

In Property Inspector, you can compare the effect of your color adjustments with the 
original colors by loading the image twice in a collection and assigning no color 
adjustment preset to the original image.

Adjustment tab
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• Blur/Sharpen

Use the slidebar or edit box to blur or sharpen your images.

• Brightness/Contrast/Saturation

Use the slidebars or edit boxes to adjust the brightness, contrast and saturation of your 
images.

• Color correction (More options)

Use the slidebars or edit boxes to add or subtract color for CMYK or RGB images. 

In Property Inspector, Fiery eXpress automatically recognizes the color space of an 
imported job and disables the color channels that are not required.

These settings are not available if your print job contains spot colors. Nor can color 
corrections be applied to CMYKRGB or CMYKOG files.

Gradation tab

• Gradation preset

Select a gradation preset from the drop-down list box. To create a new gradation preset, 
make your settings on this tab and click the plus (+) button.

In the Preferences dialog, clicking the right arrow (>) button opens the folder in which the 
vcc gradation presets are saved. You can copy vcc files to Fiery eXpress installations on 
other computers. This provides an easy way to replicate settings.

Gradation tab
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• Gradation (More options)

Define which color channels you want to “tweak” by selecting a color channel from the 
drop-down list box. Which channels are available depends on the ink colors supported by 
the selected printer.

The “In%/Out%” table initially shows values for 0% and 100% only. Make your changes 
by:

– Typing additional input/output percentage values in the table

– Modifying the gradation curve in the diagram

– Using the gamma and linear slider bars

• Global changes (More options)

– The “Gamma” setting increases or decreases the output ink percentage for an input 
value of 50%. Applying this setting affects the lightness of all color values, but mainly 
the mid-color tones.

– The “Linear” setting reduces the percentage of ink that is applied for 100% input and 
modifies all values below 100% in a linear fashion. Applying this setting affects the 
lightness of all color values equally

See also: 

“Performing a visual linearization correction” on page 129
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Printer (Preferences dialog)/Print (Property Inspector)

Device tab

• Device type

The drop-down list box contains a list of all supported output devices. Select your printer 
from the list.

Make sure that the appropriate media profiles are installed, otherwise you will not be able 
to set up the output device. If necessary, you can install additional media profiles from the 
software DVD.

• Print

Select “All” to print all pages of a multipage job. To print out only certain pages, select 
“Page/Sheet” and type in individual page numbers or a range of pages. For example, to 
print pages 2, 6, 10, 11, 12 and 13, type in 2,6,10-13.

Type the number of copies to print. If you print three copies of a three-page job, the pages 
are output in the following order: 1, 1, 1, 2, 2, 2, 3, 3, 3. If you prefer to output sorted 
copies, select the appropriate check box. In this case, the pages of your document are 
output as follows: 1, 2, 3, 1, 2, 3, 1, 2, 3.

Device tab
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Connection tab 

• Print to system printer (More options)

Select this radio button to print to a Windows printer that has already been set up as a 
system printer. The available printers are listed in the drop-down list box. This setting is 
only available for Windows.

Connection tab
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• Print via network

Select this radio button to print to a network printer. You can set up a connection via 
TCP/IP or via Bonjour.

– Custom IP Address

In the drop-down list box select “Custom IP Address”. In the edit box, type the IP 
address of the network printer. The printer’s TCP/IP address may be a defined name or 
a series of numbers, e.g. 10.1.149.33. Ask your system administrator if you are not sure 
of your printer’s TCP/IP address.

– Bonjour

Bonjour is a standard component of Macintosh OS X operating systems. To print to a 
network printer that supports the network protocol Bonjour, select the printer name as 
you would a locally connected printer. The IP address is automatically detected.

Windows users can download the Bonjour software from the Apple website at http://
www.apple.com/support/downloads/bonjourforwindows.html.

You can hide printers connected via Bonjour by deselecting the check box “Show 
Bonjour devices” (More options).

You can check that a connection to the printer has been properly established by clicking 
Test. To test the connection, the printer must be switched on. If you receive an error 
message, consult your system administrator for advice.

Select the type of TCP/IP protocol that your printer uses for data transfer (More options).

– RAW on port:

Select this radio button if your printer supports RAW printing. Most printers support 
RAW printing to port 9100. However, this setting depends on the network settings 
made at the printer and may be different.

– LPR. The queue name is:

Select this radio button if your printer supports LPR printing. Then type the queue 
name in the edit box.

It is normally only necessary to type a queue name if you are printing via a Unix system 
or a print server with multiple interfaces. In most cases, you can leave this edit box 
blank. See your printer manual for further information.

• Print via port

Select this radio button and choose the name of a printer from the drop-down list box. 
The drop-down list box lists printers connected via USB. The printer must be switched on 
when you start Fiery eXpress. Otherwise, it will not be automatically detected.

See also: 

“Setting up Fiery eXpress” on page 18
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Media set tab

• Media profile

– Ink type

Select the type of ink that is inserted in your printer.

– Media name

Select the name of the media you will be printing on.

– Print quality

Select a combination of color space, resolution and print quality for the selected 
printer. The print quality settings are extracted from the media profile.

All media profiles MUST be located in the EFI Media Profiles folder. If you have 
created your own custom media profile or want to use a media profile that you have 
obtained from a third-party provider, make sure it is implemented correctly.

In the Preferences dialog, clicking the right arrow (>) button opens the folder in which 
the media profile and associalted epl base linearization are saved. 

Media set tab
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• Calibrate (More options)

Printer calibration is only possible from the Preferences dialog.

– Calibrate

Regular calibration ensures that the color reproduction of your printer remains 
constant. The button is only available if your printer is equipped with an internal color 
sensor and an automatic closed-loop calibration feature.

• Connect Profile (More options)

The following settings concern implementing custom media profiles and are only available 
in the Preferences dialog. You can implement a media profile that you have created 
yourself or one from a third-party provider.

– New media name

To implement a custom media profile, define a name, under which the media will be 
displayed in Fiery eXpress.

– Profile path

Click Choose and browse to your custom media profile. The selected profile path is 
displayed.

– Connect new media to profile

This button is enabled when you select a valid epf file and define a media name and a 
profile path. Click this button to create a firm link between the media profile and the 
epl file. The epl file contains details of the ink, media type and media quality which 
you selected. The new profile is saved to the My Profiles folder inside the EFI Media 
Profiles folder.

See also: 

“Creating and implementing custom media profiles” on page 128
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Media size tab 

• Source

Choose between roll or single-sheet media. In the case of single sheets, select the cassette 
from which the media will be fed.

• Format

Select the format of the media inserted in the printer. To define your own sheet format, 
type in the required width and height and click the plus (+) button.

• Borderless printing (More options)

This setting is available for printers that support borderless printing. However, it cannot be 
applied to some media formats.

If this setting is used in conjunction with a scaling factor, the output is scaled to the size of 
the sheet.

If no scaling factor is selected and the page is larger than the size of the media, clipping will 
occur. If the page is smaller than the size of the media, the output will have a white border.

Media size tab
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• Media length correction (More options)

This feature lets you correct any inconsistency in the length of the printed output which 
may occur as a result of the particular combination of printer and media that you are 
using.

Normally, job length and printout length are the same. However, if you discover that your 
printout is longer or shorter than it should be, you can adjust the output length.

The file Lineal_01.ps is provided for this purpose. The printed image displays a set of ruler 
markings 0.5 x 0.5 m. Print out the file and measure the length of the ruler markings. If 
the measurement is not accurate, you can compensate for the difference by typing the 
target length and the actual measured length in the appropriate edit boxes.

This setting is independent of the hardware setting available at the control panel of some 
printers.

See also: 

“Applying custom media formats” on page 132

Special tab

The settings available on this tab are printer-specific and vary according to the printer selected 
on the Device tab. See your printer manual for details of printer-specific features.

Special tab
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Job list

Displayed information
The job list provides an overview of loaded jobs.

It gives information about:

Job list

Column heading Description Default in 
Fiery eXpress 
for Proofing

Default in 
Fiery eXpress 
for Photo

Job Status Each job status is indicated by a 
specific color to make it easier to 
identify jobs of a particular status.

x x

Name Name of job x x

Job Preview A thumbnail image is displayed of 
each loaded job.

x x

Dimensions Dimensions of job x

Color space RGB, CMYK, CMYK+ x x

File Format File format of job x

Size Job size in KB/MB x

Job ID Consecutive job number x

Pages Number of pages in job x

Date, Time Date and time the job was 
submitted for printing

x

Printer Selected output device x

Media Set Applied media set x

Last Error Last displayed error x
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These are the default headings. You can add additional columns or remove the default ones by 
right-clicking on a column heading and selecting the required items from the context menu. 
“Job status” and “Name” cannot be removed.

The context menu also contains the commands “All”, “None” and “Default”, which enable 
you to configure the job list with one mouse click. If you choose “None”, only “Job Status” 
and “Name” are displayed.

You can change the order of the columns by holding down the mouse button on a column 
heading and dragging it toward the left to a new position. The position of the columns “Job 
Status” and “Name” cannot be changed.

In addition, you can sort the order of jobs displayed in the job list according to any column 
heading. Click on a column heading to list jobs in ascending order. Click the column heading 
again to reverse the order.

Context menus
Some of the most frequently used commands are available via a context menu.

Command Right-click on

Empty area 
of job list

Job Collection Collected 
job

Import Job x x x x

Delete Job — x x x

Save Changes — x x x

Print — x x x

Preview — x x x

Export to TIFF — x x x

Cancel — x x x

New Collection — x — —

Refresh Collection — — x x

Add Job to Collection — — x x

Move Job from Collection — — — x

Reveal in Explorer/Finder x x x x

Preview Size x x x x
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Preview window
The preview window displays the job selected in the job list.

Preview window
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The preview window also shows you if the page does not fit fully on the selected media. This 
is illustrated by a red border. and the cropped part of the page is shown as semi-transparent. In 
this case, select an appropriate media size or scale the page to fit.

Preview toolbar
The following tools are available for altering the appearance of a preview.

Increases or reduces the size of the page in the preview window. Define a scale factor in the 
edit box.

Zooms in on the preview. Select the tool and click or drag inside the preview window. 

Selects a page. For multiple page selection, hold down the <Shift> key. A context menu is 
available when you right-click on a selected page, with which you can alter the appearance and 
layout.

Activates the crop tool to enable you to select a specific area of a previewed page. 

Moves the preview around the preview window. If the preview is larger than the preview 
window, scroll bars appear left and bottom. Hold down the left mouse button and move it 
around inside the preview window.

Activates the crosshair cursor. The crosshair cursor displays the current cursor coordinates to 
help with more precise repositioning, cropping and scaling of images.

Example of a loaded page that 
is bigger than media size
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Use the arrows to scroll through a multi-page job or through a multi-page collection.

Maximizes the preview by hiding the main toolbar, the job list, the Property Inspector and the 
status bar. Click the button again to return to original view.

Maximizes the size of the Fiery eXpress program window to the full screen by hiding the 
menu bar, the status bar and the Windows taskbar. Click the button again to return to 
original view.

Opens a list box for changing the background color of the preview area.

Page positioning tools
A number of visual aids, such as guides, grid and rulers, are available for precise page 
positioning. 

Keyboard shortcuts
The following key combinations are available to manipulate pages in the preview window. 
Mainly, they correspond to the shortcuts that you will already be familiar with from popular 
graphics programs.

In the case of key combinations, many of the shortcuts that can be applied to individual pages 
can also be applied to multiple page selections on a collection.

• General

Function Key combination Windows Key combination Macintosh

Show Preferences dialog <Ctrl>+F1 F1

Show Setup Wizard 
(Windows)/Show Setup 
Assistant (Macintosh)

<Ctrl>+F2 F2

Show/hide preview window F3 F3

Show/hide job list F4 F4

Show/hide Property 
Inspector

F5 F5

Show/hide main toolbar F6 F6

Show/hide preview toolbar F7 F7

Show/hide status bar F8 F8

Maximize preview <Ctrl>+<Shift>+<M> <Apple>+<Shift>+<M>

Full screen <Ctrl>+<Shift>+<F> <Apple>+<Shift>+<F>

Show context menu for a 
selected page (Edit menu)

Right-mouse click on a 
page

Right-mouse click on a 
page

Select page Click on page Click on page
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• Collection

• Zoom

Reset page <Ctrl>+<Shift>+<R> <Apple>+<Shift>+<R>

Go to next page of 
multipage document

<Ctrl>+<Page down> <Apple>+<Page down>

Go to previous page of 
multipage document

<Ctrl>+<Page up> <Apple>+<Page up>

Go to first page of 
multipage document

<Ctrl>+<Home> <Apple>+<Alt>+<Page 
down>

Go to last page of multipage 
document

<Ctrl>+<End> <Apple>+<Alt>+<Page up>

Select all jobs in job list <Ctrl>+<A> <Apple+<A>

Move selected pages in 
preview

Drag cursor Drag cursor

Scroll up through jobs in 
job list

<Ctrl>+<Arrow up> <Apple+<Arrow up>

Scroll down through jobs in 
job list

<Ctrl>+<Arrow down> <Apple+<Arrow down>

Function Key combination Windows Key combination Macintosh

Add page to selection or 
remove page from selection

<Shift>+click on page <Shift>+click on page

Select jobs in a cropped area Mouse click and drag lasso Mouse click and drag lasso

Refresh collection <Ctrl>+<Alt>+<R> <Apple><Alt>+<R>

Function Key combination Windows Key combination Macintosh

Zoom in/out • <Ctrl>+<+>/<->

• <Alt>+Scroll wheel

• <Apple>+<+>/<->

• <Alt>+Scroll wheel

Fit sheet to window <Ctrl>+<0> <Apple>+>0>

Fit to actual size <Ctrl>+<Alt>+<0> <Apple>+<Alt>+<0>

Fit selection to window <Ctrl>+<F> <Apple>+<F>

Zoom into selected area <Ctrl>+drag lasso <Apple>+drag lasso

Function Key combination Windows Key combination Macintosh
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• Rulers and grid

Context menus
The Edit menu commands are also available via a context menu when you right-click on a job 
in the preview window.

See also: 

“Edit menu” on page 27

Forcing a preview
By default, the setting “Create preview when loading job” is selected. If this setting is 
deselected, jobs are displayed as a gray rectangle in the preview window. However, you can still 
force a preview of a selected job or collection using one of the following methods:

• In the toolbar, click Calculate Preview.

• From the File menu, choose Preview.

• In the job list, right-click the mouse button. From the context menu, choose Preview.

You can also use these same commands to update a preview. Unlike rotation, mirror and 
scaling settings that are applied “on the fly”, changes that affect color output are not 
immediately visible and require you to refresh the preview.

Status bar

The status bar at the bottom of the program window gives details of the total number of jobs:

• loaded in the job list

• selected in the job list

• being processed

• that generated an error message during processing

It also displays the Fiery eXpress product and indicates if the program is licensed or running 
in demo mode.

In Windows, the total number of loaded jobs and the number of jobs that failed to print are 
displayed in the tool tip of the program icon in the system tray.

Function Key combination Windows Key combination Macintosh

Show/hide ruler <Ctrl>+<R> <Apple>+<R>

Show/hide grid <Ctrl>+<G> <Apple>+<G>

Status bar
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PRINTING

This chapter describes different methods of printing via Fiery eXpress, from loading a job 
directly in Fiery eXpress to printing from an application.

It assumes that you have already correctly set up your software. The Setup Wizard describes a 
minimum of basic settings that are necessary to get your software up and running. Make sure 
that Fiery eXpress is correctly set up before proceeding.

Once you have achieved a simple printout, you can go on to experiment with the many 
different settings provided by Fiery eXpress.

It is recommended that you use a simple image file for your first printout to prevent errors 
occurring during job processing. Jobs with spot colors, for example, require additional settings 
in Fiery eXpress in order to be output correctly.

It is important that you license your software. If Fiery eXpress is not licensed, all your 
printouts will be overlaid with a demo stamp.

See also: 

“Product registration” on page 15

“Setting up Fiery eXpress” on page 18

“Supported file formats” on page 87

Supported file formats
Fiery eXpress supports the following file formats:

File format Fiery eXpress 
for Proofing

Fiery eXpress 
for Photo

JPG x x

JPG2000 x x

TIFF (RGB, L*a*b*, CMYK) x x

TIFF with indexed colors x x

PS (composite and separated) x

PDF (composite and separated) x

ImagePDF x x

EPS (single DCS) x
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Printing directly from Fiery eXpress
If you followed the Setup Wizard displayed during the installation procedure, Fiery eXpress is 
already set up for printing. No further settings are necessary to obtain a printout.

TO PRINT DIRECTLY FROM FIERY EXPRESS

1 Load media in your printer.

2 Start Fiery eXpress.

3 Load a job using one of the following methods:

• In the toolbar, click Import Job and browse to your image file.

• From the File menu, choose Import Job and browse to your image file.

• In the job list, right-click the mouse button. From the context menu, choose Import Job 
and browse to your image file.

• Use the drag-and-drop function to release the following onto the job list:

– an image file

– a folder containing image files

– a shortcut to an image file or a folder containing image files

• On Macintosh, use the drag-and-drop function to release an image file on the program 
icon in the Dock.

4 Highlight your job in the job list. Then, submit your job to the printer using one of the 
following methods:

• In the toolbar, click Print.

• From the File menu, choose Print.

• In the job list, right-click on the job. From the context menu, choose Print.

Alternatively, you can set up the workflow to start printing automatically as soon as a job is 
loaded. See “Workflow tab” on page 41 for further information.

ImageEPS x x

PSD x x

BRP, RPF (EFI Remoteproof Containers) x

RAW x x

File format Fiery eXpress 
for Proofing

Fiery eXpress 
for Photo
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See also: 

“Setting up Fiery eXpress” on page 18

“User interface” on page 25

Printing via Unidriver
Unidriver is a special printer driver developed by EFI and shipped with the software. It 
enables you to print directly to Fiery eXpress from any application.

Windows
Follow the steps described below to install, set up and print with Unidriver in Windows.

TO INSTALL UNIDRIVER

You will find the Unidriver installation file on the software DVD.

1 Copy the EFI Unidriver.exe file to the computer desktop of the computer on which you want 
to install Unidriver.

2 Double-click on the file EFI Unidriver.exe.

3 Follow the on-screen instructions to install Unidriver.

4 Click Finish to conclude the installation.

You can now set up Unidriver for the operating system prior to printing. Alternatively, you 
can set it up when you submit a job from graphics application.

TO SET UP UNIDRIVER IN PRINTERS AND FAXES

Make sure that Fiery eXpress is running before you perform the following steps.

1 In Printers and Faxes, right-click on the printer “Fiery eXpress Unidriver” and choose 
Properties from the context menu.

The Fiery eXpress Unidriver Properties dialog opens.

2 On the General tab, click Printing Preferences.

The following dialog appears:

Logon dialog
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3 Make sure that Fiery eXpress is selected in the drop-down list box “Type”.

4 Type the IP address of the Fiery eXpress computer and click Connect.

Fiery eXpress can be set up to disallow users printing via Unidriver. If you get an error 
message to this effect, contact the administrator of Fiery eXpress.

The Unidriver Preferences dialog opens.

The tabs show the print settings made in Fiery eXpress. If you do not wish to use the settings 
from Fiery eXpress, you can make your own custom settings and apply them to jobs. When 
you have made your required changes, select the check box “Use my settings”.

5 Click OK to exit the Unidriver Preferences dialog.

6 In Printers and Faxes, right-click on the printer “Fiery eXpress Unidriver” and choose Set as 
Default Printer from the context menu, if required.

TO PRINT FROM AN APPLICATION

The actual steps may vary slightly from the description below, depending on the application 
from which you are printing.

1 In the graphics application, select the print command.

2 In the print dialog, make sure that the printer Fiery eXpress Unidriver is selected.

Unidriver Preferences dialog
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3 Proceed as follows:

• If you do not need to check Unidriver settings, continue with the on-screen instructions to 
print your job.

• To view or make changes to Unidriver settings before printing, click Printing Preferences, 
Properties, or similar, depeding on the application from which you are printing.

If an error message informs you that the connection failed, click OK. Make sure that 
Fiery eXpress is running. Then follow the steps in “To set up Unidriver in Printers and Faxes” 
on page 89 to set up a connection to Fiery eXpress.

If an error message informs you that the selected Fiery eXpress does not allow Unidriver 
connections, contact the administrator of Fiery eXpress.

Macintosh
Follow the steps described below to install, set up and print with Unidriver on Macintosh.

TO INSTALL UNIDRIVER

You will find the Unidriver installation file on the software DVD.

1 Copy the EFI Unidriver file to the computer desktop of the computer on which you want to 
install Unidriver.

2 Double-click on the file EFI Unidriver.

3 Follow the on-screen instructions to install Unidriver.

4 Click Quit to conclude the installation.

TO SET UP A CONNECTION TO FIERY EXPRESS

Make sure that Fiery eXpress is running before you perform the following steps.

1 In Print & Fax, click the plus (+) button.

2 On the More Printers tab, select Fiery eXpress Unidriver from the pull-down menu.

3 On the Automatic tab, select the IP address of the Fiery eXpress computer and click Add

If the IP address is not displayed in the list, click the Manual tab and type the IP address in 
the appropriate edit box. Then click Add.

The Fiery eXpress Unidriver printer is added to the printer list. It is now available for selection 
in the printer dialog of graphics applications.

TO PRINT FROM AN APPLICATION

The actual steps may vary slightly from the description below, depending on the application 
from which you are printing.

1 In the graphics application, select the print command.
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2 Select the Fiery eXpress Unidriver as the printer.

3 From the appropriate pull-down menu, choose Fiery eXpress Unidriver from the list of 
applications.

Selecting Fiery eXpress 
Unidriver in the application
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4 Click Change Settings.

The Unidriver Preferences dialog opens.

The tabs show the print settings made in Fiery eXpress. If you do not wish to use the settings 
from Fiery eXpress, you can make your own custom settings and apply them to jobs. When 
you have made your required changes, select the check box “Use my settings”.“

5 Click OK.

The job is submitted to Fiery eXpress.

Printing via a hotfolder
A hotfolder enables users, who do not have Fiery eXpress installed on their computers, to 
copy jobs to a centrally located folder on the network. All jobs placed in the hotfolder are 
loaded in Fiery eXpress according to the settings defined for the hotfolder.

TO SET UP A HOTFOLDER

Make the following settings in the Preferences dialog.

1 In General, click the Job Detection tab.

2 Select Activate hotfolder.

Unidriver Preferences dialog



PRINTING 94

3 Click Choose and browse to the folder that you want to set up as a hotfolder.

The folder can be anywhere on the network. However, make sure that all users have the 
appropriate access rights.

4 Select the folder and click OK.

5 In General, select the Workflow tab.

Jobs placed in a hotfolder are copies of the original file. On the Workflow tab, you can define 
whether or not the files placed in the hotfolder are deleted once the job has been output. If 
jobs are not removed from the hotfolder after printing, they will be reloaded the next time you 
start Fiery eXpress.

6 For file deletion of print/preview files, select Automatically after printing or Delete after.

If you choose “Delete after”, type a time interval in the edit box.

7 Click OK to close the Preferences dialog.

8 Place a job in the hotfolder.

The job appears automatically in the job list of Fiery eXpress and is processed according to all 
settings made on the Preferences dialog.

See also: 

“Workflow tab” on page 41

“Job Detection tab” on page 45

Virtual printing
To print straight from an application, you need to set up Fiery eXpress as a virtual printer. 
This requires you to make certain settings in Fiery eXpress and on the computer on which the 
graphics application is installed. When Fiery eXpress has been correctly set up as a virtual 
printer, you can select it in the print dialog of the graphics application.

Whether or not Fiery eXpress is visible as a printer in the network is controlled by protocol 
drivers. If no protocol driver is installed, it may not be possible for Fiery eXpress to 
communicate with the computer on which the application is installed. Ensure that the 
necessary protocol is installed before setting up Fiery eXpress as a virtual printer.
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Installed protocols according to operating system
The table below illustrates which protocols are supported by which operating systems.

* The Windows service needs to be installed.

The following tables show whether the virtual printer will be available to the user depending 
on which protocol is installed.

Protocols supported by operating system Windows 
2003/
2008 
Server

Windows 
XP

Windows 
Vista

Macintos
h OS X

AppleTalk Yes* Yes* Yes* Yes

TCP/IP Yes* Yes* Yes* Yes

SMB Yes Yes Yes No

Protocols installed on Windows XP/Windows 
Vista Client computer

Prints to Fiery eXpress installed on:
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AppleTalk No No No No

TCP/IP Yes Yes Yes Yes

SMB Yes Yes Yes No
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Protocols installed on Windows 2003 Client 
computer

Prints to Fiery eXpress installed on:
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AppleTalk Yes No No No

TCP/IP Yes Yes Yes Yes

SMB Yes Yes Yes No

Protocols installed on Macintosh OS X Client 
computer

Prints to Fiery eXpress installed on:
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AppleTalk Yes Yes Yes Yes

TCP/IP Yes Yes Yes Yes

SMB Yes Yes Yes No

Protocols installed on Macintosh OS 9 Client 
computer

Prints to Fiery eXpress installed on:
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AppleTalk Yes Yes Yes Yes

TCP/IP No No No No

SMB No No No No
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Setting up AppleTalk for Windows XP
The Windows XP Professional and Windows XP Home operating systems do not support 
AppleTalk printing by default. For this reason, a special EFI AppleTalk driver is provided on 
the software DVD.

Installing the EFI AppleTalk driver enables you to print via AppleTalk from any Macintosh 
application to a version of Fiery eXpress that is installed on Windows XP. The EFI AppleTalk 
driver supports all Apple Macintosh OS up to Mac OS 9 and all versions of Mac OS X.

TO INSTALL THE EFI APPLETALK DRIVER

1 From Control Panel, double-click Network connections. Then, right-click the LAN or high-
speed Internet connection and select Properties from the context menu.

The Local Area Connection Properties window opens.

2 On the General tab, click Install.

The Select Network Component Type window opens.

3 Double-click Protocol.

The Select Network Protocol window opens.

4 Click Have Disk and browse to the netefiatalk.inf file located in the Modules folder.

During installation, you may be requested to load the netefiatalk.sys file. You will find it in 
the same folder.

5 Click Open to install the printer driver, and follow the on-screen instructions.

6 After installation, return to the Local Area Connection Properties window, and display the 
properties of the newly installed EFI AppleTalk driver. Make sure that your current network 
card is displayed and that a valid AppleTalk zone is selected.

7 Close all windows and restart your Windows computer.

Read the following carefully. It may help to prevent problems when using the EFI AppleTalk 
driver.

• When you have successfully installed the EFI AppleTalk driver, make sure that a physical 
network card and a valid AppleTalk zone are selected. If there is no AppleTalk zone 
available on your network or if you are using a cross-link cable to connect the PC with the 
Macintosh, also enter the properties of the EFI AppleTalk driver. The EFI AppleTalk 
driver is directly connected to your network card and requires certain information about it. 
Selecting the properties enables the driver to get access to this information.

• Make sure to restart your Windows XP computer after installing the EFI AppleTalk driver. 
If you do not perform a restart, Fiery eXpress will not be able to detect the newly installed 
driver.
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• When you have restarted your Windows XP computer, Fiery eXpress can run a font 
download spooler and also set up hotfolders as AppleTalk printers if the AppleTalk spooler 
is enabled. If you want to perform a font download, it is recommended that you do so 
before you set up a hotfolder as an AppleTalk printer.

• The EFI AppleTalk driver is not compatible with any Microsoft AppleTalk protocol. 
Although no Microsoft AppleTalk protocol is available for Windows XP,  it is strongly 
recommended that you uninstall any Microsoft AppleTalk protocols before using the EFI 
AppleTalk driver.

See also: 

“Installation folder” on page 9

Setting up Fiery eXpress
To print straight from an application, you must first make certain settings in Fiery eXpress. 
How you set up Fiery eXpress depends on which protocols are installed on the computer.

Setting up Fiery eXpress as a virtual printer
To set up Fiery eXpress as a virtual printer, the TCP/IP or SMB protocols must be installed on 
the computer.

TO SET UP FIERY EXPRESS AS A VIRTUAL PRINTER

Make the following settings in the Preferences dialog.

1 In General, click the Job Detection tab.

2 Select the check box Activate hotfolder and define a hotfolder if you do not want to use the 
default folder.

3 Select the check box Activate virtual printer and define a virtual printer name.

This is the name that is displayed in the print dialog of the application. You can use the 
default name or define a custom name.

Custom names must not include spaces.

4 Click OK to close the Preferences dialog.

The virtual printer is visible in Print & Fax (Macintosh) and in printers and Faxes (Windows).
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5 Make sure that the virtual printer is set up for printer sharing in the operating system.

• Macintosh:

In Print & Fax, check that the virtual printer is displayed and selected. Make sure that the 
check box for sharing the printer is selected.

• Windows:

In Printers and Faxes, right-click the virtual printer icon and select Properties from the 
context menu. Click the Sharing tab and make sure that the radio button “Share this 
printer” is selected. Select also “List in the directory” to ensure that the printer can be seen 
by other users on the network.

Once you have set up Fiery eXpress, certain settings are needed on the computer on which the 
graphics application is installed. See “Setting up the client computer for TCP/IP or SMB 
printing” on page 101 for further information.

Setting up Fiery eXpress as an AppleTalk spooler
To set up Fiery eXpress as an AppleTalk spooler, the AppleTalk protocol must be installed on 
the computer. AppleTalk is a protocol used by Macintosh computers. Define an AppleTalk 
spooler only if your graphics application is installed on a Macintosh and you want to use the 
AppleTalk protocol.

AppleTalk is not supported by Windows XP. If Fiery eXpress is installed on this operating 
system, you need to install the EFI AppleTalk driver first. Alternatively, try setting up a 
connection using the TCP/IP protocol instead.

TO SET UP FIERY EXPRESS AS AN APPLETALK SPOOLER

Make the following settings in the Preferences dialog.

1 In General, click the Job Detection tab.

2 Select the check box Activate hotfolder and define a hotfolder.

3 Select the check box Activate AppleTalk spooler and define an AppleTalk printer name.

This is the name that us displayed in the print dialog of the application. You can use the 
default name or define a custom name.

4 Click OK to close the Preferences dialog.
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5 Make sure that the AppleTalk spooler is set up for printer sharing in the operating system.

• Windows:

– Select Start > Printers and Faxes.

– Double-click Add Printer and click Next.

– In the dialog Local or Network Printer, select “Local printer attached to this 
computer”. Then click Next.

– In the dialog Select a Printer Port, select “Use the following port”. Then select a port 
from the drop-down list box and click Next.

– In the dialog Install Printer Software, select the printer manufacturer “EFI”. Then 
select Fiery eXpress from the printer list and click Next.

– In the dialog Use Existing Driver, select “Have Disk” and click Next.

– In the dialog Install From Disk, click Browse and browse to the Windows PPD for 
Windows XP which is located in the Modules folder.

– Double-click the EFI_PRINT.inf file. Then click OK.

– In the dialog Install Printer Software, select the Fiery eXpress printer in the printer list 
and click OK.

– In the dialog Use Existing Driver, select “Keep existing driver (recommended)” and 
click Next.

– In the dialog Name Your Printer, type a name.

This is the name that will be displayed in the print dialog of the graphics application.

– Specify whether you want to set up Fiery eXpress as the default printer and click Next.

– In the dialog Printer Sharing, make sure that Fiery eXpress is set up as a shared printer. 
Then click Next..

– In the dialog Locations and Comment, define the location and capabilities of the 
Fiery eXpress printer, if required. Then click Next.

– In the dialog Print Test Page, output a test page, if required.

– Click Finish.

• Macintosh:

– In System Preferences, click Print & Fax.

– On the Printing tab, click the plus (+) button to open the Printer Browser dialog.

– Click More Printers.

– From the pull-down menu, select “AppleTalk”.

– From the pull-down menu, select your AppleTalk zone.

– Select the AppleTalk spooler in the printer list and click Add.
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– Click the Sharing tab and make sure that the check box “Share these printers with other 
computers” is selected. Ensure also that the check box next to the AppleTalk spooler is 
selected.

– Close all dialogs.

Once you have set up Fiery eXpress, certain settings are needed on the computer on which the 
graphics application is installed. See “Setting up the client computer for AppleTalk printing” 
on page 104 for further information.

See also: 

“Setting up AppleTalk for Windows XP” on page 97

“Setting up the client computer” on page 101

“Printing via a hotfolder” on page 93

Setting up the client computer
Before you can start printing, you must set up Fiery eXpress as a printer on the computer on 
which the graphics application is installed. The sections below give details on how to set up 
the Windows XP and Macintosh OS X 10.5 operating systems on the client side. Other 
operating systems are similar.

See also: 

“Printing from an application” on page 106

Setting up the client computer for TCP/IP or SMB printing
Make sure that you have correctly set up a virtual printer in Fiery eXpress before performing 
the following steps.

WINDOWS SERVER/WINDOWS CLIENT

In Windows, Fiery eXpress automatically creates a shared printer that can be used like any 
other shared printer.

1 Select Start > Printers and Faxes.

2 Double-click “Add a printer” and click Next.

3 Select the radio button for adding a network printer and click Next

4 Select “Find a printer in the directory” and click Next.

5 Type the name of the Fiery eXpress printer and click Find Now.

6 Double-click the Fiery eXpress printer in the list.

7 Define whether you want to set up Fiery eXpress as the default printer and click Next.

Fiery eXpress installed on: Windows XP

Graphics application installed on: Windows XP
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8 Click Finish.

You can now select Fiery eXpress as a printer in your graphics application.

MACINTOSH OS X SERVER/MACINTOSH OS X CLIENT

In Macintosh OS X, Fiery eXpress automatically creates a shared printer which can be used 
like any other shared printer. No further steps are necessary and you can select Fiery eXpress 
as a printer in your graphics application..

WINDOWS SERVER/MACINTOSH OS X CLIENT

To set up a connection to Windows, you require the Fiery eXpress.ppd. This is provided on 
the installation DVD and is also installed automatically with Fiery eXpress.

1 In System Preferences, double-click Print & Fax.

2 Click the plus (+) button.

3 On the Windows tab, select first the domain and then the Windows computer on which 
Fiery eXpress is installed.

The Windows login dialog appears.

4 Type your user name and password required to access the Fiery eXpress computer and click 
Connect.

5 On the Windows tab, select the name of the virtual printer.

6 From the pull-down menu Print Using, choose Other and browse to the Fiery eXpress ppd. 
Then click Open.

7 On the Windows tab, click Add.

The virtual printer is added to the list of available printers. You can now select Fiery eXpress 
as a printer in your graphics application.

If you experience difficulty printing via this method, you may be able to get round the 
problem by adding your Windows login details to the print command, as described below.

8 On Macintosh, start the Web browser and type http://localhost:631. Then press <Enter>.

The Common UNIX Printing System window appears.

9 Select the Printers tab.

10 Scroll down to the virtual printer that you added in Print & Fax and click Modify Printer.

11 In the window Modify Printer, click Continue.

Fiery eXpress installed on: Mac OS X 10.5

Graphics application installed on: Mac OS X 10.5

Fiery eXpress installed on: Windows XP

Graphics application installed on: Mac OS X 10.5
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12 In the window Device for, click Continue.

13 In the window Device URI for, add your Windows login data to the device URI as follows:

Old: smb://computername:139/virtualprintername

New: smb://username:password@domain/computername:139/virtualprintername

The user name and password are saved but are not visible to any user on the network.

14 Click Continue.

15 In the window Make/Manufacturer for, select EFI from the printer list and click Continue.

16 In the window Model/Driver for, select Fiery eXpress from the list and click Modify Printer.

MACINTOSH SERVER/WINDOWS CLIENT

1 Select Start > Printers and Faxes.

2 Select “Add a printer” and click Next.

The Welcome to the Add Printer Wizard appears.

3 Click Next.

4 Select the radio button for adding a network printer and click Next.

5 Select the radio button for connecting to a printer on the Internet or on a home or office 
network.

6 Fill in the text input field URL by entering the IP address of the Macintosh server computer 
and the port number 631.

For example: http://xx.xxx.xx.x:631/printers/virtualprintername (where xx.xxx.xx.x stands for 
the IP address of the Macintosh computer on which Fiery eXpress is installed.

7 Click Next.

8 Continue to follow the on-screen instructions .

9 Click Finish.

Fiery eXpress is added to the list of available printers and can be selected in your application.

See also: 

“Setting up AppleTalk for Windows XP” on page 97

Fiery eXpress installed on: Mac OS X 10.5

Graphics application installed on: Windows XP
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Setting up the client computer for AppleTalk printing
Make sure that you have correctly set up Fiery eXpress for AppleTalk spooling before 
performing the following steps.

MACINTOSH SERVER/MACINTOSH OS X CLIENT

1 Copy the Macintosh PPD from the installation folder to the following location on the hard 
disk of the computer on which the application is installed: 
Macintosh HD:System:Library:Printers:PPDs:Contents:Resources.

2 Make sure that Fiery eXpress is started.

3 In System Preferences, click Print & Fax.

4 Click the plus (+) button.

5 On the AppleTalk tab, select your AppleTalk zone.

6 From the printer list, select the Fiery eXpress printer.

This is the AppleTalk spooler name defined in Fiery eXpress.

7 Click Add.

Fiery eXpress is added to the list of available printers and can be selected in your application.

MACINTOSH OS X SERVER/MACINTOSH OS 9 AND MAC OS X CLASSIC MODE CLIENT 

1 Copy the Macintosh PPD from the installation folder to the following location on the hard 
disk of the computer on which the application is installed: 
System extensions:Printer descriptions.

2 Make sure that Fiery eXpress is started.

3 Open the Chooser.

4 Make sure that AppleTalk is active.

5 Select a LaserWriter 8 printer.

A list of PostScript printers is displayed.

6 Select the Fiery eXpress printer.

This is the AppleTalk spooler name defined in Fiery eXpress.

Fiery eXpress installed on: Mac OS X 10.5

Graphics application installed on: Mac OS X 10.5

Fiery eXpress installed on: Mac OS X 10.5

Graphics application installed on: Mac OS X Classic Mode 
Mac OS 9
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7 Click Create.

A dialog for selecting a PPD for your printer opens.

8 Double-click the Macintosh PPD for Fiery eXpress.

If the PPD file is grayed out and cannot be selected, use a Macintosh OS 9 shareware 
application such as FileTyper or FileXaminer to correct the file type and change it to text 
format.

9 Close the Chooser.

Fiery eXpress is added to the list of available printers and can be selected in your application.

WINDOWS XP SERVER/MACINTOSH OS X 10.5

In Windows, make sure that print services for Unix are selected. You will find this setting in 
Control Panel > Add or Remove Programs > Add/Remove Windows Components. In the 
Windows Components Wizard, select “Other Network File and Print Services” and click 
Details. Then select the check box “Print Services for Unix” and click OK. In the Windows 
Components Wizard, click Next and follow the on-screen instructions to install additional 
Windows components.

1 In System Preferences, click Print & Fax.

2 Cick the plus (+) button.

3 On the AppleTalk tab, select your AppleTalk zone.

4 From the printer list, select the Fiery eXpress printer.

This is the AppleTalk spooler name defined in Fiery eXpress.

5 Click Add.

Fiery eXpress is added to the list of available printers and can be selected in your application.

Fiery eXpress installed on: Windows XP

Graphics application installed on: Mac OS X 10.5
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Printing from an application
To print directly from an application, Fiery eXpress must already be set up correctly as a 
virtual printer or AppleTalk spooler.

TO PRINT FROM AN APPLICATION

1 Start Fiery eXpress.

If Fiery eXpress is set up for TCP/IP or SMB printing and the program is not started, 
Fiery eXpress is not available as a printer in the application. For AppleTalk printing, you can 
select the printer in the graphics application; however, an error message informs you that the 
printer is currently not available.

2 Open the file in the application in which it was created and select the print command.

3 From the pop-up menu, select the Fiery eXpress printer, and make any desired settings in the 
print dialog. Then click OK.

Your job is sent to Fiery eXpress and appears in the job list.

See also: 

“Export to TIFF” on page 48

“TIFF Export tab” on page 48

“Virtual printing” on page 94
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AN INTRODUCTION TO COLOR MANAGEMENT

This chapter is intended as a brief introduction to color management. It describes how color 
management works in Fiery eXpress and explains the importance of selecting the correct 
profiles to ensure color-accurate output.

The need for color management
Color reproduction is device-dependent, i.e. if you output the same file on two different 
devices, you will usually get two different sets of colors. Even two printers of the same model 
may show slight differences in their output.

To overcome this problem, the ICC (International Color Consortium), an organization of 
more than 50 pre-press hardware and software manufacturers, developed a recognized 
standard for color management systems to allow uniform cross-device color reproduction.  
This standard is based on a series of profiles which control color reproduction from image 
creation to image output.

You will find detailed information about color management on the website www.color.org.

Profiles
To obtain color-accurate printouts in accordance with the ICC standard, Fiery eXpress uses 
two profiles — a source profile and a media profile.

Media profiles
The media profile describes the color reproduction properties of the printer model you are 
using. It ensures that the largest possible color gamut is achieved during printing.

A set of media profiles for each printer is provided with your software. When you select a 
particular ink type, media name and print quality on the Media set tab, Fiery eXpress 
automatically assigns the appropriate media profile based on these settings.

A base linearization forms the basis for the media profile. It contains details of the quantities 
of color, under which the media profile was created, i.e. the color values necessary to achieve 
the maximum density of color while, at the same time, using as little ink as possible.
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Each media profile is attached (“patched”) to a particular base linearization (epl) file which is 
loaded automatically with the media profile.

See also: 

“Setting up Fiery eXpress” on page 18

“Media set tab” on page 76

“Creating and implementing custom media profiles” on page 128

“Performing a visual linearization correction” on page 129

Source profiles
The source profile describes the color reproduction properties of the input device. 
Fiery eXpress provides:

• CMYK source profiles

CMYK source profiles describe the color gamut of a printing press. They provide a reliable 
way to predict the color results of a production run on a traditional printer.

In Fiery eXpress, you can load:

– any icc profile provided with the software

– any icc profile provided by your printing company that has been created for a specific 
printing press.

• RGB source profiles

RGB source profiles ensure high-quality output in vivid colors. They do this by 
maintaining the larger RGB color gamut during job processing.

CMYK profiles
Fiery eXpress is shipped with the following CMYK profiles:

• ISO profiles

For information on the latest ISO profiles, visit the website www.eci.org.

You will find detailed information on the ISOnewsmedia profiles on the website 
www.ifra.com.

• PSR profiles

For information on the latest PSR profiles, visit the website www.eci.org.

• Indigo_HP3000Glos_exp05.icc

This profile was created for use with an HP Indigo printing press 3000.
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RGB profiles
Fiery eXpress is shipped with the following RGB profiles:

• ECI-RGB.V1.0.icc/ECI-RGB.v2.icc

This profile was created for the standardized RGB color space of the European Color 
Initiative. ECI-RGB is the color space used to store medium-independent data in order to 
avoid the practical problems that occur in processing CIELAB color data.

You will find detailed information on the ECI homepage at www.eci.org.

• sRGB Color Space Profile.icm

This profile was created for outputting sRGB data. sRGB is a standardized RGB color 
system from Microsoft/Hewlett-Packard with defined primary colors. The profile enables 
you to output sRGB data, but is also suitable for general RGB data such as scans or photos 
from digital cameras.

• AdobeRGB1998.icc

This profile employs the default RGB working color space.

• PhotoGamutRGB_avg6c.icc

This profile is intended for files from digital cameras and scanners. It works best in 
conjunction with the rendering intent “Relative colorimetric”.  However, for files with 
extremely large color spaces and containing very highly saturated colors, the rendering 
intent “Perceptual” may produce better results. It is recommended that you also use black 
point compensation, if available.

You will find more detailed information on this profile at photogamut.org.

• ProPhoto.icm

The ProPhoto RGB color space, also known as ROMM RGB, is an output referred RGB 
color space, developed by Kodak, that offers an especially large gamut designed for use 
with photographic output in mind. The ProPhoto RGB color space encompasses over 
90% of possible surface colors in the CIE L*a*b* color space, and 100% of likely 
occurring real world surface colors making ProPhoto even larger than the Adobe Wide 
Gamut RGB color space. 

Multicolor profiles
Although EFI does not provide multicolor profiles, you can use your own.

See also: 

“Creating and implementing custom media profiles” on page 128
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Simulation (reference) profiles
The simulation profile describes the color reproduction properties of the printing machine 
you wish to simulate on your inkjet printer. A set of generic profiles is provided with your 
software.

Rendering intents 
In Fiery eXpress, jobs are processed first using the selected source profile and then using the 
media profile, before being output on your printer. This process involves the conversion from 
and to different color spaces.

Irrespective of whether your input file was created in CMYK or RGB format, Fiery eXpress 
converts the color values first to L*a*b* before converting them to the CMYK color space — 
the color space used by your printer. This conversion is controlled by rendering intents.

The L*a*b* color system is a device-independent color space that describes each color 
uniquely in mathematical terms.

Each color space has a different color gamut. For example, the RGB color space has a much 
wider color gamut than the CMYK color space. In other words, the RGB color space is able to 
display a much wider range of colors. This is the reason why RGB images, such as photos, 
appear much more vivid than images created in the CMYK color space.

Converting colors to a different color space may mean that colors in the source color space lie 
outside the color gamut of the destination color space and therefore cannot be displayed.

This problem can be solved by selecting an appropriate rendering intent. Rendering intents 
define how the colors of the source color gamut will be adjusted to fit into the destination 
color gamut.

For example, you can define whether colors that lie within the destination color gamut should 
remain unchanged or whether the whole color gamut should be compressed, i.e. scaled, to fit 
into the destination color gamut, thus preserving the range of colors that is displayed.

In a similar way, each output device also displays a different color gamut and even output 
devices of the same printer model reproduce colors slightly differently.

L*a*b* color space
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In Fiery eXpress, rendering intents are used to adjust the color gamut of your printer to that 
of the reference printer (or printing press) being simulated.

The following rendering intents are available in Fiery eXpress:

• Relative colorimetric (no paper white)

This rendering intent compares the white point of the source color space with that of the 
destination color space and adjusts all colors accordingly.  All colors within the color 
gamut of the destination color space are accurately reproduced. Any colors outside the 
color gamut of the destination color space are replaced by the colorimetrically closest color 
that can be reproduced. 

This rendering intent is suitable for creating proofs with no paper white image.

• Absolute colorimetric (paper white)

This rendering intent leaves all colors within the destination color gamut unchanged, thus 
maintaining color accuracy. If the destination color gamut is smaller than the source color 
gamut, it may mean that two distinct colors from the source color gamut are mapped to 
the same color in the destination color gamut.

This rendering intent is suitable for creating proofs with paper white simulation.

Paper white simulation means that the color of the reference media is also simulated. For 
example, if you select the profile “Newspaper” in combination with the rendering intent 
Absolute colorimetric (paper white), your image will be printed on a gray background to 
simulate the color of newsprint.

• Perceptual

This rendering intent preserves the visual relationship between colors in a way that is 
perceived natural to the human eye by compressing all colors and scaling them to fit into 
the available destination color space. Since all colors are affected, even those that would 
normally lie within the color gamut of the destination color space are compressed — even 
if they could normally be accurately reproduced. In this way, shadow details are preserved.

This rendering intent is most suitable for printing photographic images, where having the 
largest possible color space is more important than a color-accurate print result. It is 
therefore not recommended for the output of color-accurate proofs.

• Saturated

This rendering intent aims to preserve vivid color at the expense of accurate color. The 
source color gamut is scaled to the destination color gamut, but preserves relative 
saturation instead of hue, so color hues may shift if the destination color space is smaller 
than the source color space.

This rendering intent is designed primarily for business graphics, where bright, saturated 
colors are more important than the exact relationship between colors (such as in a 
photographic image).
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• Relative colorimetric with black point compensation/ 
Absolute colorimetric with black point compensation

If the black point of the source color space differs greatly from that of the target color 
space, you can apply black point compensation on top of the rendering intents “Relative 
colorimetric” and “Absolute colorimetric”.

With black point compensation, the full dynamic range of the source color space is 
mapped to the full dynamic range of the destination color space. However, if the black 
point of the source color space is darker, contrast is lost during the conversion.

Activating black point compensation may cause gray shadows. However, this setting can be 
applied usefully to darker source black points.

Applying black point compensation may give more shadow detail and avoid gamut 
clipping if the darkest points of the source are darker than the proofing system is able to 
print. Differences in the black point are compensated for by introducing more deviation 
between target and proof shadow areas so, although the result will be visually better, the 
measured color values may not be as good.
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HOW DO I ...?
This chapter describes in easy-to-follow steps how to use some of the more important features 
of Fiery eXpress.

Working with collections
A collection comprises an assortment of jobs output as one single job.

Assembling jobs for collective output has two distinct advantages:

• It reduces media wastage

• It lets you submit one large job at a time that is least likely to cause inconvenience to your 
flow of work, e.g. overnight.

Collection
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Setting up a collection
In Fiery eXpress, you can:

• Create a collection from loaded jobs

• Set up an automatic collection workflow

TO CREATE A COLLECTION FROM LOADED JOBS

1 Load one or more jobs in Fiery eXpress.

The individual jobs contained in a collection can be of any file format supported by 
Fiery eXpress. All settings embedded in the original file are applied.

2 In the job list, select the jobs that you want to output as a collection.

3 Do one of the following:

• From the File menu, choose New Collection.

• In the toolbar, click New Collection.

• Press the right mouse button and choose New Collection from the context menu.

A collection is created in the job list. Collection jobs always receive the name “Collection”, 
followed by a consecutive number, e.g. Collection_42. Collection files can be displayed in an 
expanded or collapsed condition. The collapsed condition shows only the collection job itself, 
but not the pages it contains. To display the collected pages click on the icon to the left of the 
collection name.

Initially, page layout is designed according to the default collection settings. You can apply a 
different layout by selecting a predefined collection preset from the drop-down list box 
“Preset” or by designing your own layout and saving it as a collection preset. See “Collection 
tab” on page 54 for details of collection settings.

TO SET UP AN AUTOMATIC COLLECTION WORKFLOW

If you wish to output all your jobs as part of a collection, you can set up a collection workflow.

Make the following settings in the Preferences dialog.

1 In General, click the Workflow tab.

2 Select the check box “Collect incoming files automatically after”. Then define the length of 
time, after which a collection should be created.

If you type in “2”, all jobs loaded within two minutes after the last job was loaded are output 
in the same collection file. Jobs loaded after the two minutes have elapsed become part of the 
next collection.
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3 Select the check box Print jobs automatically (optional).

This setting ensures that your collection files start printing as soon as the defined time span 
has elapsed. However, leaving this check box unchecked lets you perform job-specific or 
collection settings in the Property Inspector before printing.

4 In Layout, click the Collection tab.

With the settings on the Collection tab, you can be more specific about how jobs are 
arranged.

5 Click OK to close the Preferences dialog.

6 Load one or more jobs in Fiery eXpress.

A collection is automatically created in accordance with the settings you have made.

Cloning
The clone feature enables you to output multiple copies of a collected page from one original. 
You can assign each clone different job properties and save these to the collection preset.

TO CREATE A CLONE

1 In the collection, select one or more pages.

2 Do one of the following:

• From the Edit menu, choose Clone.

• Hold down the right mouse button and choose Clone from the context menu.

A cloned page appears.

3 Apply any required job settings and refresh the preview:

• In the toolbar, click Refresh Collection, or

• In the File menu, select Refresh Collection

Collection presets with integrated “clone” settings are also available.

TO DELETE A CLONE

1 In the collection, select one or more clones.

2 Do one of the following:

• From the Edit menu, choose Remove Clone.

• Press the right mouse button and choose Remove Clone from the context menu.

The selected clones are deleted.

If you delete the original page, all associated clones are also deleted.
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3 Refresh the preview:

• In the toolbar, click Refresh Collection, or

• In the File menu, select Refresh Collection.

Using align/distribute edges to layout collections
The align and distribute commands enable you to position collected pages relative to each 
other.

TO ALIGN PAGES RELATIVE TO EACH OTHER

1 Select multiple pages.

You can select multiple pages in the preview by holding down the <Shift> key. Alternatively, 
hold down the <Ctrl> key to select multiple pages in the job list.

2 From the Edit menu, choose a type of alignment.

Vertical alignment (top, bottom, center) is not possible for roll media.

The illustration shows pages aligned according to their upper edges.

3 To rearrange aligned pages select multiple pages.

Randomly positioned pages

Aligned upper edges



HOW DO I ...? 117

4 From the Edit menu, choose a type of distribution.

The distribution commands rearrange pages evenly on the sheet so that their center points are 
equidistant from to each other.

 

The illustration shows aligned pages distributed according to their horizontal centers.

Making changes to collections
Once you have created a collection, you can make changes to the layout or add/delete jobs 
before printing.

To make changes to collections set up for automatic printing, you must first stop the printing 
process by clicking Cancel in the toolbar.

TO ALTER THE LAYOUT OF A COLLECTION

1 In the job list, select the collection job.

2 In Layout, click the Collection tab.

Use the available settings to alter the orientation or size of jobs.

3 Refresh the collection preview:

• In the toolbar, click Refresh Collection, or

• In the File menu, select Refresh Collection.

TO ADD A JOB TO A COLLECTION

1 Do one of the following:

• In the job list, right-click on the collection job. From the context menu, select Add Job to 
Collection, or

• In the job list, select a job and use drag & drop to release it on the collection job, or

• Select a file anywhere on the network or local hard drive and use drag & drop to release it 
on the collection job in the job list

The preview is updated automatically.

Horizontal centers distributed
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TO CHANGE THE ORDER OF PAGES IN A COLLECTION

You can swop pages around on a custom sheet. The swopped pages assume the position and 
layout settings of the page that they have replaced.

1 In Layout, click the Collection tab and select “Manual layout”.

2 In the View menu, choose Visual Aids > Collection Info to display the ID number of the pages 
in the collection.

3 On a collection sheet consisting of more than one page, select a page.

Make sure that you do not select more than one page.

4 Do one of the following:

• In the Edit menu, choose first Use Page and then the ID number of the page you want to 
swop, or

• Right-click on the selected page. From the context menu, choose Use Page and then the 
ID of the page you want to swop.

The preview is updated automatically.

TO DELETE A JOB FROM A COLLECTION

1 Do one of the following:

• In the job list, right-click on the job to be deleted. From the context menu, choose Delete 
Job, or

• In the job list, select the job to be deleted. In the toolbar, click Delete, or

• In the job list, select the job to be deleted. From the File menu, choose Delete Job.

2 Click Yes to confirm your action.

The preview is updated automatically.

You can also remove a job from a collection without deleting it. In the job list, right-click on 
the job. From the context menu, choose Move Job from Collection. Afterward, refresh the 
collection preview.

TO DELETE A COLLECTION

1 Do one of the following:

• In the job list, right-click on the collection. From the context menu, choose Delete Job, or

• In the job list, select the collection to be deleted. In the toolbar, click Delete Job, or

• In the job list, select the collection to be deleted. From the File menu, choose Delete Job.

2 Click Yes to confirm your action.
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Cropping
A number of methods are available to enable you to define and output a specific area of a 
page, without printing the whole page.

See also: 

“Collection layout” on page 55

Using the crop tool
To crop a page you must first activate the crop tool in the preview toolbar. Then, hold down 
the mouse button and drag the cursor to create a crop box. The crosshair cursor, guides and 
the snap-to function can help you to specify an exact area.

TO REPOSITION A SELECTED CROP BOX

Click inside the marquee and drag the cursor.

TO RESIZE A SELECTED CROPPED PAGE

Position the cursor on a node along an edge of the page and drag the cursor.

TO CANCEL A SELECTED CROP AREA

• Press the <Esc> key or

• From the Edit menu, choose Reset Page or

• Hold down the right mouse button and choose Cancel Cropping from the context menu 
(Windows) or

Defining the area to be 
cropped
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• Hold down <Ctrl> and choose Cancel Cropping from the pop-up menu (Macintosh)

When you are satisfied with the size and position of the crop box, proceed as follows to crop 
the page:

• Press <Enter> or 

• Click the mouse button twice or

• Hold down the right mouse button and choose Apply Cropping from the context menu 
(Windows) or

• Press <Ctrl> and choose Apply Cropping from the pop-up menu (Macintosh)

In the case of pages with crop marks, the crop marks are reapplied to the newly cropped area.

If, after cropping, you are unhappy with the result, you can uncrop the page by resetting the 
page.

Alternatively, you can also crop an image by selecting one of the image handles and dragging 
the cursor.

Cropped page
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Defining crop margins
On the Page Layout tab, you can crop a page by defining top, bottom, left and right margins.

Positioning crop marks
By defining a negative bleed value on the Marks tab, you can position crop marks to enable 
you to cut off a border from around the page after printing.

With this method, the page is printed in its full size. It is not possible to define different 
margin widths for top, bottom, left and right.

Defining crop margins

Defining crop marks
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Working with spot colors
A spot color is a specially mixed ink that is applied on the printing press, as opposed to a mix 
of CMYK inks which make up process printing. Spot colors can be produced in a much more 
vibrant range of colors than can be created from mixing process colors. As an example, they 
are often used to print company logos.

Many companies produce spot colors, together with a set of swatch books with printed 
samples. Fiery eXpress supports many of these colors in the form of internal tables.

To process jobs containing spot colors, you must either:

• define the spot colors in Fiery eXpress or

• instruct Fiery eXpress to replace non-detected spot colors with a warning color.

TO CREATE A NEW SPOT COLOR PRESET 

If your jobs regularly contain the same spot colors, you can create a spot color preset and 
integrate it in the workflow.

Make the following settings in the Preferences dialog.

1 In Color, click the Spot colors tab.

Initially, the spot color preset “None” is displayed in the drop-down list box.

Processing spot colors
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2 In the Spot color definitions table, click in the first empty row of the Name column.

The name “Untitled Spot Color” is displayed.

3 Type in the name of the spot color.

The name must match exactly the spot color name used in the graphics application.

4 In the Source column, click on the arrow to open the drop-down list box.

5 Select how you want to define your spot color.

Choose from CMYK/RGB/OG, L*a*b*, a spot color manufacturer or PRINTER.

If your printer allows you to insert additional ink containers with spot colors, you can select 
PRINTER. This setting ensures that the printer ink is used and color management for that 
color is by-passed during job processing.

“CMYK/Lab link” enables you to “map” one color to another. You should use this setting, for 
example, if the spot color used for your company logo has been defined in the graphics 
application under two different names. To apply “CMYK/Lab link”, at least one user-defined 
CMYK or L*a*b* spot color must already have been defined for the selected preset.

6 In the Map to column, define the color values of your spot color.

• For CMYK/RGB/OG and L*a*b*, type in the color values for the appropriate color space.

• For a pre-defined color of a spot color manufacturer, click on the down arrow and select 
the appropriate color from the drop-down list box. You can use this setting to quickly map 
a spot color that has been incorrectly named in the graphics application.

• If you chose “CMYK/Lab link”, click the down arrow and select another spot color from 
the same preset. This creates a link between the two colors. Any changes you make to the 
defined spot color are automatically applied to linked colors also.

The drop-down list box is empty if no spot colors are available to map to.

The illustration is an example of how to use this setting.

7 In Spot color preset, click the plus (+) button and define a name.

Be careful to define a unique name to avoid inadvertently overwriting an existing preset. Spot 
color presets are saved in bct format. You can select an available preset from the drop-down 
list box.

Creating a link to a pre-defined 
color of a spot color 
manufacturer

Creating a link to another 
defined spot color
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8 Make sure that the preset is selected in the drop-down list box.

The next time you load a job with a spot color that has been defined in the selected preset, it 
is immediately recognized.

If your job contains spot colors that are not defined in the selected preset, an error message is 
displayed on the Info tab and job processing is aborted. In this case, follow the instructions to 
define spot colors for an incoming job.

TO DEFINE SPOT COLORS FOR A LOADED JOB

If you load a job with a spot color that has not previously been defined, an error message is 
displayed on the Info tab. You must define the spot color in the Property Inspector before the 
job can be processed.

Spot colors of supported spot color manufacturers (Pantone, HKS, TOYO, DIC) are 
automatically recognized in Fiery eXpress and do not have to be defined — as long as the 
name used in the graphics application in which the file was created matches exactly the spot 
color name defined by the spot color manufacturer.

1 In Color, click the Spot colors tab.

The names of all detected colors (process and spot colors) are listed in the spot color 
definitions table. For non-defined spot colors, the “Source” column displays “Unknown”.

It is possible that missing spot colors have previously been defined in an existing preset. If this 
is the case, simply select the appropriate preset from the drop-down list box. To check that the 
spot colors have been correctly recognized, make sure that the job is selected in the job list and 
refresh the preview. If the preview is displayed correctly, you can go on to output the job. To 
define new spot colors, continue with the steps below.

2 In the Source cell of an unknown spot color, click on the arrow to open the drop-down list 
box.

3 Select how you want to define your spot color.

Choose from CMYK/RGB/OG, L*a*b*, a spot color manufacturer or PRINTER.

If your printer allows you to insert additional ink containers with spot colors, you can select 
PRINTER. This setting ensures that the printer ink is used and color management for that 
color is by-passed during job processing.

“CMYK/Lab” link enables you to “map” one color to another. You would use this setting, for 
example, if the spot color used for your company logo has been defined in the graphics 
application under two different names. To apply this setting, the preset must already contain 
at least one user-defined CMYK or L*a*b* spot color..
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4 In the Map to column, define the color values of your spot color.

• For CMYK and L*a*b*, type in the color values for the appropriate color space.

• For a pre-defined color of a spot color manufacturer, click on the down arrow and select 
the appropriate color from the drop-down list box. You can use this setting to quickly map 
a spot color that has been incorrectly named in the graphics application.

• If you chose “CMYK/Lab link”, click the down arrow and select another spot color from 
the same preset. This creates a link between the two colors. Any changes you make to the 
defined spot color are automatically applied to linked colors also.

The drop-down list box is empty if no spot colors are available to map to.

The illustration is an example of how to use this setting.

5 In Spot color preset, click the plus (+) button and define a name.

Be careful to define a unique name to avoid inadvertently overwriting an existing preset. Spot 
color presets are saved in bct format. You can select an available preset from the drop-down 
list box.

6 Make sure that the preset is selected in the drop-down list box.

7 To check that the spot colors are correctly recognized, make sure that the job is selected in 
the job list and refresh the preview.

If the preview is displayed correctly, you can go on to output the job.

Spot colors defined in the Property Inspector are job-specific. If you want the spot colors to be 
detected in all jobs, you must select the preset in the Preferences dialog.

Creating a link to a pre-defined 
color of a spot color 
manufacturer

Creating a link to another 
defined spot color
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TO OUTPUT NON-DEFINED SPOT COLORS

Occasionally, you may wish to output jobs without defining unknown spot colors first. 
Fiery eXpress enables you to replace these colors with a warning color which makes them 
easily recognizable in the printout.

1 Load a job with unknown spot colors.

An error message is displayed on the Info tab.

2 In Color, click the Spot colors tab.

3 Select the check box “Replace unknown spot colors with warning color”.

The default warning color is bright green but you can define your own warning color by 
typing CMYK values in the appropriate edit boxes. You can reselect the default warning color 
at any time by clicking Default.

4 Click Save in the toolbar to save the setting.

5 To see the effect, load a job with an unknown spot color.

The unknown spot color is displayed in the warning color:

• in the table of spot color definitions

• in the preview

Outputting undefined spot 
colors with a warning color
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TO MODIFY SPOT COLORS AND PRESETS

After you have defined spot color presets, you can:

• Edit spot colors

In the Preferences dialog, you can rename spot colors and alter their color values by 
overwriting the table definitions on the Spot colors tab. To apply the new settings, click 
the plus (+) button and overwrite the preset. Alternatively, you can save the preset under a 
new name. The new settings are applied to all jobs that you subsequently load.

• Add spot colors

You can add spot colors to an existing preset in the Preferences dialog or in the Property 
Inspector. When you save your changes, you can:

– Overwrite the current preset. In this case, the original preset is no longer available.

– Save the preset as a copy of the original preset. In this case, the new preset receives the 
name extension “_Copy n” to indicate that it is a modified version of the original.

– Save the preset under a new name.

In the Property Inspector, the spot color definitions table displays only those spot colors 
that are detected in the current job. However, it is possible that the selected preset contains 
colors that are not visible. Therefore, before overwriting an existing preset, make sure that 
you are not inadvertently deleting “hidden” spot colors. You can do this by selecting the 
preset on the Spot colors tab of the Preferences dialog. The spot color definitions table lists 
all the spot colors defined in the selected preset.

• Delete spot colors

You can delete a spot color from a preset in the Preferences dialog but not in the Property 
Inspector. To delete a spot color, select it in the table, right-click the mouse and choose 
Delete from the context menu. Then click the plus (+) button and overwrite the original 
preset with the updated spot color information.

You may need to refresh the job preview to apply the changed spot color information.

• Delete spot color presets

To delete a preset, select it in the drop-down list box and click the minus (-) button. 
However, make sure that the preset is not being applied to any jobs. If you get an error 
message, delete the jobs with the appropriate job IDs or apply a different spot color preset 
to the jobs and try again.

See also: 

“Spot colors tab” on page 68

“Forcing a preview” on page 86
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Creating and implementing custom media profiles
Fiery eXpress provides media profiles for a wide range of different media. The very first time 
you launch the application, Fiery eXpress searches for installed profiles. Then, when you 
make your media settings on the Color tab, Fiery eXpress automatically assigns the EFI media 
profile that matches your settings.

However, you may want to create your own profiles for media types that are not standardly 
supported in Fiery eXpress. This section describes how to create and implement your own 
media profiles.

TO CREATE A MEDIA PROFILE

Make the following settings in the Preferences dialog.

1 In Color, click the Management tab.

2 Select the color preset No Color Management.

This ensures that no profiles are applied. Profiles affect the printed color quality, so by 
selecting “No Color Management” you make sure that your output is based on the true color 
properties of the printer.

3 In Printer, click the Media set tab

4 Make your required settings for media name and print quality.

If your media type is not listed, select a media which best matches the properties of the media 
you are using.

5 Click Calibrate and calibrate your printer using the automatic closed-loop color calibration 
feature.

Not all printers are equipped with an internal calibration feature. If the button is disabled, 
your printer does not support this function. In this case, skip this step.

6 Load the chart provided with your profiling software in Fiery eXpress and print it out.

The chart you are required to print depends on the measuring device you are using. See your 
profiling software manual for further details.

When you have printed out the chart, it is important that you do not modify any of the 
settings in Fiery eXpress.

7 Follow the instructions in your profiling software manual to create a media profile.

TO APPLY A MEDIA PROFILE

When you have created your media profile, you need to apply it in Fiery eXpress. You do this 
by creating a firm link between the media profile and the epl file which contains details of the 
ink, media type and media quality which you selected.

You can also use the following procedure to implement a media profile that you have obtained 
from a third-party provider.
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Make the following settings in the Preferences dialog.

1 In Printer, click the Media set tab.

2 In Connect Profile, type a media name in the edit box.

This is the name that will later be displayed for selection in Fiery eXpress. Names of max. 63 
characters are permitted.

3 Click Choose and browse to the location of the media profile.

4 In the dialog Select icc profile, select the media profile and click Open.

5 Click Connect New Media to Profile.

6 Click OK to confirm that the profile has been successfully connected.

The media profile is saved to the subfolder My Profiles of the profiles folder. The folder 
contains the epl and the icc profile.

Your media profile is now ready for use. You can select it as the media name on the Media Set 
tab.

Performing a visual linearization correction
Performing a visual linearization correction can help you to improve the overall color quality 
of your output. It enables you to finetune individual color channels, which may be producing 
unsatisfactory results, by increasing or decreasing the percentage of ink. For example, you 
might want to perform a visual linearization to “perk up” a weak cyan.

The linearization method available in Fiery eXpress is based purely on manual adjustments to 
the density curves and should only be performed as an emergency measure by experienced 
users.

TO PERFORM A VISUAL LINEARIZATION

You can make settings in the Property Inspector or in the Preferences dialog. Visual 
corrections made as a job setting in the Property Inspector can also be selected in the 
Preferences dialog and applied to the workflow.

1 Output a job that clearly illustrates the color to be tweaked.

In a proofing environment, you can compare the output with a reference print, but in a 
production environment, color is often purely a matter of personal preference.

2 In the Color dialog, click the Gradation tab.
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3 From the drop-down list box Channel, select the color or colors you want to modify.

Which channels are available depends on the ink colors supported by the selected printer. You 
can modify:

• Individual colors (Cyan, Magenta, Yellow, Black, Orange/Red, Green, Blue)

• Four colors at once (CMYK)

• Three colors at once (CMY)

• Multicolor (all available colors)

Once you have defined values for an individual color (C, M, Y, K, O/R, G, B), the options 
“CMYK”, “CMY” and “Multicolor” are dimmed.

4 Edit the gradation curve for the color(s) you have selected, using any of the following 
methods:

• Move the “Gamma” slider bar

This setting increases or decreases the output ink percentage for an input value of 50%. 
Output values of between 25% and 75% are possible. The ink density values on either side 
are modified to produce a smooth gradation curve. 0% and 100% remain unchanged. 
Applying this setting affects the lightness of all color values, but mainly the mid-color 
tones.

Gamma setting
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• Move the “Linear” slider bar

This setting reduces the percentage of ink that is applied for 100% input. The lowest 
possible output value is 50%. All values below 100% are modified in a linear fashion. 0% 
remains unchanged. Applying this setting affects the lightness of all color values equally.

• Define individual values along the gradation curve

Hold down the cursor on a point along the curve. A node appears and the current x 
(input) value is displayed in the table. Move the cursor until the required input and output 
values are displayed in the table. Release the mouse button.

Repeat this step to alter any number of specific points along the gradation curve.

• Define individual values in the “In%/Out%” table

The “In%/Out%” table initially shows values for 0% and 100% only. X represents the 
input value and y the output value. To make changes, type additional values in the table 
and press <Enter>.

If you need to edit a value, select the table cell and double-click. To delete a table row, 
select one of the table cells, hold down the left mouse button and drag the cursor across the 
row. Then press <Delete>.

You can undo your changes and reset them to the default values by clicking the appropriate 
Reset button.

Linear setting
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5 To save your changes, click the plus (+) button and define a name for your gradation preset. 

Be careful to define a unique name to avoid inadvertently overwriting an existing preset. 
Gradation presets are saved in vcc format. You can select an available preset from the drop-
down list box.

6 Make sure that the preset is selected in the drop-down list box.

7 Reprint your job and compare the result with the original printout. If further tweaking is 
necessary, repeat the steps above.

TO DELETE A GRADATION PRESET

Make the following settings in the Preferences dialog.

1 Make sure that the preset is not being applied to any jobs in the job list.

2 Select the preset in the drop-down list box and click the minus (-) button.

If you get an error message, delete the jobs with the appropriate job IDs from the job list and 
try again.

See also: 

“Gradation tab” on page 71

Applying custom media formats
If your media format is not supported in Fiery eXpress, you can define your own.

TO DEFINE A MEDIA FORMAT

Make the following settings in the Preferences dialog.

1 In Printer, click the Media size tab.

2 In Source, select the type of media inserted in the printer. Choose between roll or single-
sheet media.

The media must be either the same size or larger than the media format to be defined.

3 In the Width and Height edit boxes, type in the dimensions of the media format.

When you type in values, “Custom” is displayed as the format.

4 Click the plus (+) button.

The media format is added to the list of formats. It is automatically selected.
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TO DELETE A MEDIA FORMAT

Make the following settings in the Preferences dialog.

1 In Printer, click the Media size tab.

2 In the drop-down list box Format, select the media format.

Custom media formats are saved at the bottom of the list.

3 Click the minus (-) button.

Backing up and restoring settings
Setting up exactly the right settings for your needs can be quite time-consuming. For this 
reason, Fiery eXpress provides a feature to save settings in a backup file. You can restore 
settings that have been backed up on a PC on a Macintosh computer and vice versa.

Backup files are saved in EBK format and contain:

• Media profiles (icc files)

• Collection presets

• Visual correction files (vcc files)

• Spot color tables (bct files)

• Monitor profiles (icc files)

• L*a*b* optimization files (3cc files)

You can restore a backup file at any time, e.g. after reinstalling Fiery eXpress.

TO CREATE A BACKUP COPY

1 From the Actions menu, choose Backup.

The dialog Save backup file opens.

2 Define a file name for the backup file.

The default name is “EFI_Backup_xxxxxx”, whereby “xxxxxx” stands for the current date. If 
you create two backup files on the same day, the original file will be overwritten. To avoid this, 
define a new name.

3 Define a backup location.

Backup files are saved by default to the desktop.

4 Click Save.
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TO RESTORE A BACKUP FILE

1 From the Actions menu, choose Restore .

2 Browse to the location of the backup file and select it.

3 Click Open.

4 Click OK when the restore is finished and restart Fiery eXpress.

Installing online program updates and profile updates
EFI continues to develop its products even after product launch, e.g. to improve functionality 
or to increase printer support. It is, therefore, recommended that you regularly run the update 
procedure to make sure you always have the latest version installed.

Online updates are only possible if Fiery eXpress is installed on a computer with Internet 
access.

TO SEARCH AUTOMATICALLY FOR UPDATES

1 From the Help menu, choose Online Update.

The dialog Online Update opens.

2 Select the check box Check for updates. Then, from the drop-down list box, select whether 
you want Fiery eXpress to check for available updates on a daily, weekly or monthly basis.

When the time interval has elapsed, Fiery eXpress automatically searches the EFI website for 
software and profile updates. If updates are found, the appropriate updater application starts 
automatically for you to download the new files.

If you do not want Fiery eXpress to search automatically for available updates, deselect the 
check box “Check for updates”. You can click Check for Software Update or Check for 
Profiles Update manually whenever you wish.

Dialog Online Update
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TO INSTALL SOFTWARE UPDATES

1 In the dialog Online Update, click Check for Software Update.

The Updater dialog appears.

2 Follow the on-screen instructions to download and install updated files.

By default, the check box “Save a copy of the installation files to the desktop” is checked. This 
enables you to easily install the updated files on multiple computers while only downloading 
the files once. Deselect the check box if you do not require the files to be copied to the 
desktop.

Dialog Online Update
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TO INSTALL PROFILE UPDATES

1 In the dialog Online Update, click Check for Profiles Update.

2 Click Next.

3 Click the tab for your printer manufacturer.

It may take a few moments for the supported printer models to be displayed.

4 Select the check box for your printer model to install all available profile updates.

Clicking the plus (+) button next to the printer model enables you to select profiles for 
specific media.

5 Click Add profiles to save your profile selection.

6 Click the Selected profiles tab. Then click Update now.

The new profiles are downloaded and installed.

7 Click Finish to conclude.

Using Japanese fonts
Fiery eXpress is automatically installed with two Japanese printer fonts: Heisei-Mincho-W3 
and Heisei-KakuGo-W5. Both are CID-formatted, low-res fonts. Additional double-byte 
fonts can be purchased from third-party providers. However, note these must also be low-res.

To use the Japanese fonts, you must license your software and set up Fiery eXpress for 
AppleTalk printing.

Dialog Online Update
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TO INSTALL JAPANESE FONTS FROM A THIRD-PARTY PROVIDER

1 Follow the instructions for installation provided with your third-pary Japanese fonts.

Generally speaking, you can install the fonts from a Macintosh OS 9 computer in the same 
AppleTalk network as Fiery eXpress. During the installation, you may be required to select the 
Fiery eXpress printer. Make sure that you select the correct AppleTalk spooler name.

2 When the font download has been completed, restart Fiery eXpress.

3 To print using low-res Japanese fonts, choose Start Font Download from the Actions menu.

Activating font download converts Fiery eXpress to a low-res printer.

See also: 

“Product registration” on page 15

“Virtual printing” on page 94

“Processsing resolution (More options)” on page 47
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UNINSTALLING

This chapter describes how to uninstall Fiery eXpress.

TO UNINSTALL IN WINDOWS VIA THE SETUP PROGRAM

1 Insert the software DVD into the DVD-ROM drive.

The start screen starts automatically. If the start screen does not appear, double-click the 
Start.exe file located on the DVD.

2 Click Install Fiery eXpress to start installation.

3 In the Welcome window, click Remove and follow the on-screen instructions to complete 
uninstallation.

Make sure to restart your computer before reinstalling.

TO UNINSTALL IN WINDOWS VIA CONTROL PANEL

1 Open Control Panel.

2 Proceed as follows:

Windows XP:

Double-click Add or Remove Programs.

Windows Vista:

Double-click Programs and Features.

Windows 2003:

Double-click Software.

3 In the list of installed programs, select the application you want to uninstall and click 
Remove (Windows XP and Windows 2003) or Uninstall (Windows Vista).

4 Follow the procedure for your operating system for removing programs.

Make sure to restart your computer before reinstalling.
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TO UNINSTALL ON MACINTOSH

1 Insert the software DVD for your operating system into the DVD-ROM drive.

2 Double-click the program icon to start the setup procedure and follow the on-screen 
instructions until you come to the Custom Install dialog.

3 From the pop-up menu, select Uninstall.

4 Click Uninstall and follow the on-screen instructions to complete the procedure.

Make sure to restart your computer before reinstalling.
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GLOSSARY

This glossary gives a brief explanation of the terms used in this manual.

Base linearization

Printers do not work in a linear fashion and achieve their maximum color density at 
approximately 50%. As a result, test charts for creating profiles do not have differentiated 
color patches for the upper chromatic values.

A base linearization makes the density curve of the printer linear (input value = output value), 
thus creating an important basis for ICC-compatible color management.

Each media profile is attached (“patched”) to a particular base linearization (epl) file which is 
loaded automatically with the media profile.

EFI Remoteproof Container

The file format used to send the image file and settings from one location to another. The EFI 
Remoteproof Container consists of a pdf file (print file) and a jdf file (settings file), which are 
compressed into a single file, the so-called EFI Remoteproof Container with the file extension 
RPF.

Gamma

The ratio of the contrast range between original and reproduction. A gamma value of 1 means 
that the original and copy proof have the same contrast range.

L*a*b*

A color model based on the model proposed by the Commission Internationale d'Eclairage 
(CIE) in 1931 as an international standard for color measurement.L*a*b* color is designed to 
be device-independent and perceptually uniform. L*a*b* color consists of a luminance or 
lightness component (L*) and two chromatic components: the a* component (from green to 
red) and the b* component (from blue to yellow).

Paper white simulation

Paper white simulation means that the color of the reference media is also simulated. For 
example, if you select the reference profile “ISOnewspaper26v4.icc” in combination with the 
rendering intent “Absolute colorimetric (paper white)”, the image is printed on a gray 
background to simulate the color of newsprint.

Page

A page refers to any job (image file) loaded in Fiery eXpress and displayed in the preview 
window. It can be a single job or part of a collection.
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pdf

Portable Document Format. A method of formatting documents in such a way that they can 
be viewed and printed on multiple platforms using the freely available Adobe Acrobat 
Reader™.

Printer relinearization

A process to re-adjust the color densities and return the printer to the original state used to 
generate the base linearization.

Rendering intent

Rendering intent refers to the way the CMM (Color Management Module) handles out-of-
gamut colors during a conversion from one color space to another.

RGB

The additive color system used in digital cameras and computer monitors where red, green, 
and blue light is captured separately and then combined to create a full color image.

Sheet

A sheet refers to the media size. It is not necessarily equal to the media size inserted in the 
printer. You can select or define a media size that is smaller than the inserted media size. For 
example, it is possible to define a collection sheet of A2 size to be output on 17” roll media.
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A
Activation Wizard/Assistant 29
Aligning, pages

in a collection 116
individual 54

AppleTalk printing
client computer 104
EFI eXpress 99
in Windows XP 97

B
Backup and restore 133
Bi-directional printing 47
Black ink, using 66
Borderless printing 78

C
Calculating page size 41
Camera settings

displaying 51
selecting 60

Cleaning up files 30, 44
Collections 113

aligning images 116
automatic workflow 41
cloning 115
creating 114
editing 117
info 32
layout 55
picture mount 57
presets 55
preview 27

Color
adjustments 70

blur/sharpen 71
brightness/contrast/saturation 71
CMYK/RGB 71

management 107
predefined presets 61
visual adjustments 71, 129

Control strip 59

Crop
margins 121
marks 58, 121
tool 119

Cropping 119

D
Demo mode 14
Dongle ID 17

E
Embedded profiles 64
Error messages, viewing 51
Exif data

displaying 51
selecting 60

Export to TIFF 34, 48

F
File formats, supported 87
Fonts, Japanese 30, 47, 136

G
GPS 51
Grayscale output 63, 67

H
Hotfolder

defining 45
printing via 93

I
In-RIP separation 68
Input resolution 49

J
Japanese fonts 30, 47, 136
Job

list 80
settings 37
ticket 60

Job list
column headings 80
thumbnail images 43

INDEX
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K
Keyboard shortcuts 84

L
L*a*b* optimization 67
Language setting 39
License folder, defining 39
Licensing 15, 29

M
Margins

around collection (picture mount) 57
crop 121
non-printable 32

Measurement system, changing 39
Media

optimizing consumption 55
profiles 107

installing 21
selecting 76
updating 134

size
creating custom 132
selecting 78

Menus
Actions 29
Edit 27
EFI eXpress 25
File 26
Help 33
View 30

Monitor profiles 40

O
Optimization

L*a*b* 67
media consumption 55

Output resolution 49
Overprinting 69

P
Page

aligning 54
cropping 119
rotating 53
scaling 52
size 28

calculating 41
PDF output intent 65

Preferences dialog, accessing 36
Preview

automatic 43
forcing 86
toolbar 83
window 82

Print
engine 43
speed 47

Printer
calibrating 77
connecting 74
setting up 73

Printing
automatic workflow 41
bi-directional 47
borderless 78
grayscale 63, 67
media length correction 79
number of copies 73
page range 73
to TIFF format 34, 48
via

EFI eXpress 88
graphics application 106
hotfolder 93
Unidriver 89
virtual printer 94

Processing resolution 47
Product

differences 38
licensing 15
selection 39

Profiles
embedded 64
media 107

selecting 76
monitor 40
simulation 110

selecting 65
source 108

selecting 64
third-party 77

Program
folders 9
setting up 18
starting 14
uninstalling 138
updating 134
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Property inspector 37

R
Rendering intents 110

selecting 64
Resolution

input 49
output 49
processing 47

Reveal in Explorer/Finder 27
RGB objects, identifying 66
RIP and print on the fly 47
Rotating, pages 53

S
Scaling, pages 52
Setting up 18, 34

printer 73
Settings

backup and restore 133
basic and more options 37
job 37
workflow 36

Setup Wizard/Assistant 34
Simulation profiles 110

selecting 65
Source profiles 108

selecting 64
Spot colors 122

adding 127
defining

for a loaded job 124
for workflow 122

deleting 127
editing 127
mapping 123
outputting in warning color 69, 126

Status bar 86
Support 13, 33
System requirements 8

T
Tabs

Adjustment 70
Application 38
Collection 54
Connection 74
Device 73
Footer 59
Gradation 71
Info 50
Job Detection 45
Management 61
Marks 58
Media set 76
Media size 78
Page Layout 52
Special 79
Speed 46
Spot colors 68
Workflow 41

Thumbnail images in job list 43
TIFF export 34, 48
Toolbar

main 34
preview 83

U
Unidriver

enabling job submission via 46
Macintosh 91
Windows 89

Uninstalling 138
Unit of measurement 39
Updating, program and profiles 134
User interface 25

job list 80
keyboard shortcuts 84
main toolbar 34
menus 25
preview

toolbar 83
window 82

settings 37
status bar 86
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V
Virtual printer

client computer 101
setting up EFI eXpress 98
supported protocols 95

Visual linearization correction 71, 129

W
Work folder, defining 39
Workflow settings 36
Working color space 66
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